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HAETA KRR N o

[0049] G AL SAT— W ERAEAEN LTI TC R HUHE IR T &L a0, G I I AN B “ SR
“COL” B AL TR B AR R e W EEARTE . W R SCATV B I, S S AR S
A RS R TR IR B R o I SRHER Tk, 2 N T RE Fy 45 SR 4T BN EG
AT AT AL S (PR 2 R SR AT ENALI SRS R S I0) o FH Uk, AT ENY AR
HITE Y E 3T BN 28 BN S 4T E i 45 8 A

[0050]  ZS2SHELE T BRAATL Wi B SCHHEEG 2 SMIVT 2 07 AL o 48140, ZEALR 28 R 43 ] LA
HRRL FF HAN AT UM R IS4G . 540, 2L 7 2 (R 2% 22 0] LA ], IF HAURR &
T BR824 0 FH T B T DA Y FH B R o3« 9K, s T F T 3RSt B SOR Bk
H L E R AE

[0051] s HEJE 1

[0052]  7Efr7nFFRER IS E) b, S A EM (W, 45) 1. RT3
RGP SCREHTTP IR 5548 RIS BRI R Z4h, B0 Boa 2l e
o XBEFEHTE - BRI AT, LN BRI - B Al AR A, #
PR AT DLEA — B A H BRI ¢ 2R, W R ST e i

[0053] A48 A 75 06 Z0UAE L T7 T K BT B AT Ik A 1 o A8 BT 7 PR IS 1) S it
i, 24 PR LR o = S5, X R T S0 R AP IR AR B URT P EE 10 LU 2l
7R

[0054] /document. xml

[0055] /tickets/ticket. xml

[0056] /images/march/summer. jpeg
[0057] /pages/paged. xml

[0058] 1 b 3CHT LA DR, 7EIX—SEfe) 4444 B DL RRE -

[0059]  @¥EfFA R TAE G A RGP RIS 4 o

[0060] @A LLIERMT ( “/”) Hif.

[0061] @5 CHFARGH KA URT A M4 —HE, S E 4 vl DU 8 — 2 2R A0 H S 44
T (fELL EoRflrh, o4 tickets. images/march) #EZHZ3 850 2 4554 o

[0062] @ i%4) /=45 M ALTE H IERMT & A 1L

[0063] @& TG —BRUTAER M RAT IS4

[0064]  EEEE[F A, H Ty 2 a4 BRI, TG RT T 4 A RO A S X AR SR
AR R AE 422 B 11 o S 30 01 44 B0 U] 3 BTG I AR HE ¥ URT iy 4% LI o 4 FE A St )
ARSI JiAE) T8 S 4 RS A 5 REC 2396, [R]— AR IRAT (URT 288 A0k ) #l
TG 5 (AHIC URT 51 ) A 3. 3 (ERARHT ) g XIW abs_path FiEAHILAL.

[0065] LA R B ANZY A B 2 abs_path, 1E A EEH4 -

[o066]  @u17y 3(URT Ayyksra) A1 3. A( &Ml &) o LHERS 2 AEH T4 .
[0067]  @UITT 4. 1 (ZrBUARIART ) F R 7 BOFR RAFASIE Y T304

[0068]  @{F—fif B A dad i BAA A IR A A% a8 0 = ( « /7 2B SROTE A T2 A
HEM

[0069] &4 IKTEE /R R UTE
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=" /" segment * (" /" segment)

= % pchar

= unreserved|escaped |

N O e O L L T L
= alphanum |mark

=" %" hex hex

=digit|” A" |" B” |" ¢c” |” D" |" E" |" F" |

" I
a

‘ " b//
" " ‘ " " ‘ " "

" " 7 7 7 " 1 i
e | e | f

‘//, " ‘// " |//

~

= lowalpha|upalpha

N N I I B T U S A I 9 A I AN A I A

="’ [T " [ [ dn [ e [ g [ T

Y R 1 I S S I S S I /R
S S R R R N |

1" 1" 1 1 1 1 1 1 1 i i i " 1" 12 1"
s" 1"t 1" | | | |

y Z

— A// ‘// B// ‘// C// ‘// D// ‘// E// ‘// F// ‘// G// ‘Il H// ’//
" J// ‘// K// ‘// L// ‘// M// ‘// N// ‘// O// ‘// P// ‘// Q// ’//

1z Su ‘u TH ‘H UH ‘H VH ‘N Wu ‘N XN ‘N Yn |n Zu
— O// ‘// 1// ‘// 2// ‘// 3// ‘// 4// ‘// 5// ‘// 6// |// 7// ‘

7 8// ‘// 9//

= alphaldigit

[0070] part_name
[0071] segment
[0072] pchar
[0073]

[0074] unreserved
[0075] escaped
[0076] hex
[0077]

[0078] mark
A TENIEY
[0079] alpha
[0080] lowalpha
i

[0081]

e

[0082]

[0083] upalpha
o

[0084]

R" |

[0085]

[0086] digit
[0087]

[0088] alpnanum
[0089]

A VR BB PP A I BOR I T B KRBTSO R G P AR

Forb, P B b R BTAT AT RO SO, MY sUR R R I SE R A o 44 T I
FAASTAF I i (BRI, AR 10 BRSSP B SR B RE . AR T, BE A AT,
IRRE IR AU i 4 oy SR E R R RS AR AE — EAIBCA REARS e R L

[0090]  #RMFHZANHE

IR HiAr s . HARL, ST A o R AR P AR T R (43

7 ) ARt HA MR A 7 B AE A7 3k

[0091]

FEATIR A HSL ] b, B — PR A WRRA, eE T A4k

Leliiakasits

FEAERRE . SRR s B L 5

[0092]
[0093]
[0094]
[0095]

image/ jpeg
text/xml

text/plain jcharset ="

us—ascii”

WA RALE RFC 2045 ( 2 & BB BB /2 5 MIME) ) Hh g LI BT 7s IR AE 4 v

. ELAARHE, B — W AR TR FE ARSI (a0, text (3CA)) FHRB (Hlan, plain (4l
A )) UL REEF =N EESEE (HU, charset =" us-ascii” ) ;2415

Wl b

11
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[0096]  #if-EHE

[0007] W EAFE S R EMOARGI . AR — A B F], AR B AP S R2A
ar AR ICSCEATENR o AR SO EAEADN EHR RIS, 4815 2 A0 BEFRIC SO, ] R0 A
SERTRIRI S . A FSBIA XML B Bt & n A URT SR 7RI L5 | H o A H R
A]BE, 75 B SCHH 44 I AR URT Ak 2z (8] 1l 5

[0098]  h AVFLEAL AL URL, 4P Al 2% TR0 N A P 1) URT I, DA 2548 FH AR 2R 1#) URT i
FERRI LA B N 94 A URT SR “PEF 7 RAREE, 11 URT KR8 425 8 H T ST
47 |2 558 o

[0099] 1, 45 URT http://www. example. com/foo/something. package, ¥ X} /abe/
bar. xml 5| FHfERE A EWRE 4 N /abe/bar. xml {354, M 3E URThttp://www. example.
com/abc/bar. xml,

[0100] WA HA MW I — BB 20 I3 — AR5 | I, BV 548 ARG URT. s
FIAHXT S I H AV RSN A — BB s BIA R AR (s8R 3 2k B30 S0 RS RI2
) MAMEEGH RS

[0101] >k & AT B 5 AN T-0 5% 5 | R « 54l URT” SRfdre . B, 38
I 2 URT 2 3B 44

[0102]  FHEAHEHA LU & AR AR

[0103] /markup/page. xml
[0104] /image/picture. jpeg
[0105] /images/other picture. jpeg

[o106] 4 SR “markup/page. xml” FAFELE R, . /images/picture. jpeg” 15|, WIHK ]
IRHEIN, 125 | FH DA A AR P B A4 ¢/ images/picture. jpeg”s

[0107]  JELEpy A RAIGLAE Tl 5 i A AN [ ZE A R 78 55 BRAZEA URT 1757 4
(FAEIXBET 56 7 — I, 8 FH B A T e (92560 URT iy AEBR A 2E4S URT,

[0108] A7 B, “Hbu Ik A A (9 — 30 23 R 2 1 s 2 I o 78 URT Ao, A 7 0 B
PRIRATE [ DL 40 REC2396] o 7EZ 2%, AL LA FRE R 77 X T4 . Hodkh, 4r BOR AL & e bk
(R0 23 B ) ARSI I s BE R R ME S BT ER o 9, ZERAISC AR, 2 BEATAR TR, 7F
XML SO, e Al IS xpath BRI XML SO E—# 55

[0109] 7} ERFRINFT 45 A @ HE AR URT — A2 F, SR U HE A 3B A i 2 B o 2 BEAR IR
R PTARIE I, I HHAS X Z: (“47) 2455 URL 245, Hilt, B2 URL I—3#4%, (H 20
eiG URL — & .

[o110]  DURHEASEE T M dr 4 3 2edn J, U BRIy AR AR A S R . 1%
RIE M ARVPESA R SRS AR o AR T, AR GRS, HEAPE T s T b 24
AAERAF R G [ HAE I B O A A 2 AU S T . 8 RFiE—15 1, et
TR T E, A BRI L T B IR RE TR R T RE .

01111 JhAbgy I 7 R T FH F S/ MME sk 2 Dk /D 30 4 ph R IR, JRAE e
i HE BRINT A B AT T I o B3R B P PRS0 A P 15 15 3 00 R B Tt SRS ) Ak B 45, IR
AR Ao . fERAEMmBMREEIT, BEE RS E H S HILa M.
[0112]  {EfRIEA RN EFRAMNE T, ZPE H 0 5iX 87 R & . R0, A
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PSP ELZE AR R, W AT 1S & D AGEIRIX LT £ SR, HEF A2
BT BB 5 & AEARAT G G0 T HGERIX L7 £ .

[0113] @ ZRAFFAATI INBIAT KA 155 F v w44 73 J2 SR H “ STF I ” rhak FEA,
M= LR B Bl e A7 AR SO A iR LA 7 5K, 44 i S ] Be 14 PR T8 4
R — Bt o TEIZOH SO Y BN T LATE AT 5 A S A 5 16 AU, PR A7 O e
o

[0114]  @TESCHFIR“BLAE” 25 DA INA WA HE LT, BEH BACK AR5
BRI B e S e 24 o 55 B RN AR I A 4 B g T B BIAR B AT SO Rk A4 1
Feg (A]REAE JLIRAS B INIEARZ Ja K A GUID) .

[0115]  @IX—BURI— 45 B P A VAR BB “ L 8057 B 2ok e Ar
W AR, BEF LIRS BN AR & — SO P i 20— RS R, 1
L W AT FH 3K 2640, 5K 00 A B A T RO T A A 48 o

[o116] @ —H iz 3 7 cfh b — A Gl EiR B RZ — ), WEn]
A5 FH G TS IR 8 A 44 B 20 e SRk 1 e

[0117]  IXBhFEST

[o118] LA HEIA I ST A% AT DL AN RIS R SCR SR B SR AT H - AT
(K7 2 B o i g P R A NS 55 o A T — DN ERZ AN IRBIFE PR o3 i 25 il 52, 451
WSCAFRE P 2 7 R TP I 2ZE 755 5% a0, AR BSOS R A B R &
SCA T AS R AE B RE http 2RI 2 il o — ZH IR BRI 1 25 A S A R (E
PSS SRR R R 2 AN IR BRI T ASF S T AN R 28 38 R AN FE A
P E S

[0119] K%

[0120] A rP B AT AL B XA B SL AR S L o AR, — MR S X 285 | FH DU 1%
A P A A L F 7 AR S TR 38R BT, DUMER bR IC BN AR P & b . 1X
A RCH SR TR E AN R AL S 3K L8 | R A ) P A SIS Ry e S 1A 2 TR PR P S TR
2o

[0121]  BEASEXS T A AR (s s — 45 Rl i [ e A 2 dobnic ), B 1% /&
B BT WA AT TR0 8T, AR IR AT A SL e A 095 L o i, 2 SEB—x
FTEN ORI — DT BN AR G, W] B8 A 8 YR 2 72 8 i i B f k. IA I &R
G N — T BT {5 B AT T2 B, IR ARER 9, y 2 B — TG 5 IR A
ST LV A Bl D S IS 00 (90 2, e 22 104 o TPl A TS B e A0 SRS AT AP ]
AP A BRI ) o AH S BRACHER I R A AU A T S BRI 2 A5 &,
AR EEOC R IR . KR TE T A2 51, Hpk e 0 AF 1T B e vl DUBRAE G &R, 1
LTHmEZNAFEES AR £S5 E 3, SR L XML 2o M ml il A
AMHRBREI KRR, BaE TR HER SR

[0122] {54, Ho 3R A% I AR AT FH X — A% X IR0 AN [R) 1) i 7 ZRA% i A7 ik . ANJniE
KT HFREE TN RS RIS B RS RIS RS R lan, NP
AR A T R DL A L SRS AH ORI I o B o R —ORBISC R W T

[0123] < ? xml version=" 1.0" ? >

13



CN 1961304 B WO B 9/81 ¥

[0124] <xsd:schema xmlns:mmcfrels =" http://mmcfrels-PLACEHOLDER”
[0125] xmlns:xsd =" http://www. w3. org/2001/XMLSchema” >

[0126] {xsd:attribute name =" Target” type =" xsd:string” />
[0127] {xsd:attribute name =" Name” type =" xsd:string” />
[0128] {xsd:element name =" Relationships” >

[0129] <{xsd:complexType>

[0130] {xsd:sequence>

[0131] (xsd:element ref = " Relationship ” minOccurs
=" 0" maxOccurs =" unbounded” />

[0132] <{/xsd:sequence>

[0133] <{/xsd:complexType>

[0134] {/xsd:element>

[0135] {xsd:element name =" Relationship” >

[0136] {xsd:complexType>

[0137] <{xsd:simpleContent>

[0138] {xsd:extension base =" xsd:string” >

[0139] {xsd:attribute ref =" Target” />

[0140] {xsd:attribute ref =" Name” />

[0141] {/xsd:extension>

[0142] <{/xsd:simpleContent>

[0143] <{/xsd:complexType>

[0144] {/xsd:element>

[0145] </xsd:schema>

[o146]  iZ K@ X T WA XML JT 2%, — D #EFR A “relationships”, 75 — MK N
“relationship”, “relationship” Juz H THIAR AR A XK, FFHREA LT E
PE 2 (1) “target”, BN T IR E X R BIFAE, (2) “name”, BHR/R T R AM R A siky
Mo B X T “relationships” TR AT ERNENHZ A “relationship” JuE, HAUH
T Xt “relationship” JURMELE K — 1 HIC.

[0147]  BRALPTHEAR RGN TTEG N T B S BALH], DAERFRA R R . KRR
BT RN A YRR B bR R RSN 7. SRR A I A &R ]
DI Ee “ R IL7, A5 B A A A i 28, R, e oar F I T B, IF Hoig
FRHBBE AT A6, XL R RV SRR ¢ R AT LSRR 2 B A G
[o148] KA THE AEEMIRE VP A T E e A, X —1F
B AR B, b, R S B N BRI E g e E B . WA
()7 A8 048 B N PR R IR P T T B R RN B Sy R o B, B B SRS B AR T b
B I IR A 0 10 ANE A — 40, R 0 O LA e AR A, B A
BE 2 I H OB e B 2 TeR o 7E 5 — i rh, A n] Res B R B 31 JPEG
BUGE SO JPEG BB S AT AR YU R S e . 02 JPEG #% X LA X —
TRIEASLER . AR, HEAL R R A 515 RV P W) JPEG SR v B 1 A& 2
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JPEG 544 o

[0149]  ZE—ASEHEHIH, A CR T I XML SRR R KR BasPEN— P E K
ZA IR BB A A SCBR I K R B o R R ARG (N2 A application/
PLACEHOLDER ( S FHFERF / AR ) LA XML ik ) H Tz rI< &% .

[0150] NI 4 7xH T EREE 400, A “H 4 (spine) 7 #4E 402 (R TR AR ) H=
AN UTTH 406,408 F1 410 HPEfE— o HIEr 22402 75— HC I A 0 [y B AH OQIBE ) 4T BV 2R
P 404, Fiak, U 2 A H A CRFTEN S 412, AR 402 20 H AT ED 4R 404 1
PR UL DU 2 BIILFT EP SRR 412 FREEATH R R kKR . 7EE 4 BIHEZIH, B 2R a1
402 HA MR R R T, B E AER R | XK, ELL R R,
[0151] <Relationships xmlns ="http://mmcfrels—-PLACEHOLDER” >

[0152] {Relationship
[0153] Target =”.. /tickets/ticketl. xml”
[0154] Name = http://mmcf-printing—ticket/PLACEHOLDER/>

[0155] </Relationships>

[0156] K& {FH B <Relationships> JCE T K ER] <Relationship> JLEHRKFEK /R, X
LEIE AT http://mmefrels (PLACEHOLDER) 44775 [ rp g S o W, ESCRI7RBIEER, LA R 3L
X7 R B AH R IR

[0157]  RERITEHALLTHmENE -

[0158]
Target ( Hir) |/ TR AN s — 3 AL B F I URT o AHXS URT
AITREAS T AT R APRE
Name (#7%) [ ME— 3l SR AR AR Bl H R RIZE %] URT.

[0159] &Pt E T SEPR I HbE . AR SR ALK 0 R I AL TR AR IR XL 7 LUK
XML 44 52785 1) e 44 228 T i Rl — i 2ok e S o HAAHE, 38 o s A A0 DRI 9 43 42 25 1) 1 44
T AEW I AT 2 A AN A SR I S R A T - IEATEATTRT DX XML 44 525 18] Fr o) —
[o160] ARV RFAIMSHHERXRFR AW, A KBRS LER&s K (i,
‘B2 W] URT JEHEH) e R] AT I e IBR 5558 ) « KRB A s A HT
PRIRSCR B AR URT — AL URT B,

[o161] & S HEAH DGR ¢ Rl I Ay B 2 e SR 8 . 7EIX— 7B, B AL )08 &Rl
¥ EAEAFE /content/ rels/spine. xml. rels H, Tfif W[ 2 KK &2 ¥ A7 4E /content/
rels/p2. xml. rels J1o VEE, WAL A T MR G B A€ . B 26, L0 Z 4/ h
YRE S TRY () MR RIAEAEIE S R _rels T 307 (DARIAR
) o HAIR X — KRB 4 Al 1] SRS AT 12 B 00 . rels ¥ RRARIE K. 1E
B B W SEFE Y, o8 R AR R N B ZRAY application/xml+relationshipsPLACEHOLDER ( fY
ST /xml+ XA GEALAT) o

[0162]  KCRK/R T2 BIA MR B TRRKER KT X ALY 46
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IR FFEH R B H AR 2 58 S 20 R AR 2 P JUIT ) o 2R, AR ZR I B ARIT
U I 1m) 38 JF5 9% B AN 2 A CERL A ik RO T A 1R B A 5% 3R 0 7 T ) B 2 38 TP I T A 2%
R)o

[0163] DA X FR ) S In) 3t g e A Wl g, A T R &SRR e (Rl ) Jriml. iX
KRBV 0] DAE I — P BiEe AR . 4Raz DL o), fn S 8 1) 2 Re s 3 H B
TR LR AR, WPREAT A SEEERE R SR T OR R,

[0164] 7 content/ rels/pl.xml.rels 7 ;

[0165] <Relationships xmlns ="http://mmcfrels—PLACEHOLDER” >

[0166] <Relationship

[0167] Target =" /content/spine. xml”

[0168] Name =”http://mmcf-printing—spine/PLACEHOLDER” />

[0169] </Relationships>

[o170] fLXKHR

[0171]  “fIe R A TH B AR Z07 RS T 4T T A 5B
A 258, AR T AEA R SO A R 44 22 T8 A ik

[0172]  ASCH 2 —FRe IR SR, S BAR MO, TRA 2 & 2B . HAg R
HN7 RS B g B B TR A KRR T IXREBEIER, B E
SR EI AL LA SR v AR 1 7R A 44 D% B 5 T 48 S ) AN A B SRR R AR 44 L - R
SESE A PR T — 27 BT . RS RAE R R R IR kR, IF HAL S R AR bR a4 4
FERAM A . HIL, BN/ _rels/. rels”.

[0173]  ZAKFHR PSR AL e A Fn AT I 2 F

[0174] RGBT

[0175] AL IR 2 KR AT B — A7 2 A AR ” A o 3R I AR AT A I A A P )30
PFo BRR THEAFAEA N I SO N A IR o B AR A i DR A A K RO E AT
FE— A, %K R BA LU N4 http: //mecf-start-part—PLACEHOLDER.

[0176]  HERRELAT - EEELE AT )

[0177]  PFrRiR IHELL E LT F T BB ATAa 2 S s 5 A R I ALl < B e AU 41
[0178]  WEFEdS A2 A B A e (. BN, s A v] DAAE R /s 30
) T8 A BRI MR 7R SCRA VAT R R 18] “ 1B 87 R 2 A Hog T “ e
Je7 AR an, AT LS AR (R NStk A ), o — AN ROR T 3L
=T R o S N W B = 8

[0179]  IXPIRRRAIHERRERE (PR REAS ) LU T AT AL B 1 A feAss
A8 o HERSGE A WT ZH e H e HERRGER A, BRI A8 2, W] ELA AR AN 2T 23 2 TRV IRAT IR R R IR
fro VBN —oRM, B 5, B T AL B S TR R R FIVE TR RN I 54 R K — 7 A
RERIR R P () DA RM S (R ) o« B —7niT,
RS 500 FEMR M FETENNETE RN MUAT 4. Wik 4 T 3B RoR, W4 502 ¥
BB IR 506 5B 45 HAF 508 B 7. BUE, MR IERE TIEER A, WIF A1) 504 H4 v
AR 510 SIETHM &M 512 E ¥

[0180]  HEARARAT XML
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[o181]  {EFTIR FFHi i) Sl ] v » FHERRCARAF A2 A I 200 XML 70 2R AR B, AT HH H
~HR A R 2 523 W o AER— DB, &R

[0182] JU% :<selection>

[0183] e

[0184] RV ITER <item>

[0185] JLZ :<{sequence>

[0186] JE It

[0187] AV FITER <item>

[0188] JUE {item>

[0189] JEYE Target— 4L RS 2 7 BB FIE1E &

[0190]  1EA—"onfl], LAF & B SO 5 7R 1) XML -
[0191] MainDocument. XML

[0192] {selection>

[0193] {item target =”EnglishRollup. xml” />

[0194] {item target =”FrenchRollup. xml” />

[0195] {/selection>

[0196] EnglishRollup. XML

[0197] {sequence>

[0198] {item target =”EnglishIntroduction. xml” />
[0199] {item target =”EnglishFinancials.xml” />
[0200] {/sequence>

[0201] FrenchRollup. XML

[0202] <sequence>

[0203] {item target =”Frenchlntroduction. xml”>

[0204] {item target =”FrenchFinancials.xml”>

[0205] </sequence>

[0206]  £FiX— XML 4, MainDocument. xml & 7~H0H HEN B4, IF HARYE “selection”fr
5 P8R T BEAEH “Hitem” PR EEERIAE I, B “EnglishRol lup. xml” #1“FrenchRol lup.
xml” Z A /E G+

[0207]  #R¥E “sequence” $r2%, EnglishRollup. xml il FrenchRollup. xml 24 B H % H
[ “1tem” BRAEEAL IS B I BUE FFAE— R IRFA1 .

[0208]  FH U, ffit 1 a] L) XML SEE R IR B R AR A P 1) o X — 20 il A iR A — BB A48
Ry, IFPAT — MR - R 0E e R AE AR 2 E S5, PR I B A A1) B AN ]
et S

[0200]  ZH Hek

[0210] A [T ZH e He A 4% W] LIRS AR A6 B0 A 2k 10 BT A HERRGER A e BEas 8741 ) 146
A o WERAL KR LG A BEAR 1L £e45 AR, WA I ik Ry 2 o SRR ah ER A Ak il
A 00 336 VA b 30 15 R S RS A T 1 <dtemd, BARE AR HERR A AR PR B (243 R
AEHERR A 1 T ) o Z R e (RIEASR B, & AU AR T, LME A 240 o
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[0211] e A v X

[0212]  FS7T BIAHXT B XML 82 G, DU R R 7R E B R TN
RAMEH BRI 7. BRI, B3k XML 4248 1 @88 115 5, BLIARVF ) 132 5 0 A 45V 4 e — 1
AR TR A, (FL AR B A 8 1) SRS 1 [ 13 38 0 T O T 2 Rls 70 IRV R M P B 2
Ko BT, 25 52 20 R S SRR IR S, ) 3 el AN S A AR UE (a0, 15 4R R/
) SRAEHIERE? BRI ECHUN S HERGT A N ARSI RS . ik, TR TIBSE
TR Z R AT B U e e A i B 5 258 T 40K KN AE R IR 2 TR 1A T 1R B e B4 3
ANFI IR N AR AL

[0213] i FHAESE g ix db py 5280 T AHIE A -

[0214]  Application/XML+Selector—SOMETHING ( I AR /XML+ EHE3% — H— N &)
[0215]  Application/XML+Sequence—SOMETHING ( BN FHFE /XML+ #41) — H— %)
[0216]  3X 28 Py S A rp (1) SOMETHING HH 871 28 6 BUT #1) I 4 1 3 >Fe 5 48, 491 4, D 1)
KN E T S e B IS5, PR, 7EBEHE 48, ] & BH BT A AR ik
FEARAFA, 3 B B 3EE AR E X

[0217]  HER RIAE S0 52 ST LATR I B B B ) 152 T 46 o0 20 B X IR B A R 91 ) 2
IR it

[0218]

N 7R A AL

P

Application/XML+Selector+SupportedContentType|F&E T+ H N AR ALEIN 7 (B 7 HL .
( S RIRET /XML+ EFEds + SCRFI P AR ) TR PEHR R 25 2 AR R A
X AT B — I

[0219]  1EA—ARB, FZE W, e RS B v i Se A, I HAE 5O i A R
T IR DX 3. A6 R A9 TR, T B AR AT R T AL S Quicktime R AR 3 IR Ao
XI5 — > ] A2 Quicktime AT A A& A 5 3 BE AR 1K) SR 1T, B8 K BACHE 42, T
IR R SCHE R Y B IE A% 28, A7 76 Bl i AR 1 S A% X —JPEG. M= A E ik SR
A BT Bl A A e R B R At 2 A, AR P 3 IR S T T JPEG G, FRR T —
Ff SupportedContentType ( SZHF N AR ) b He4s, 13 Wi A P i E VLR A B4R
Quicktime AR A, WILEEE Quicktime FLHH, 75 MILHE JPEG K.

[0220]  HH UL, 40 bR, HE 4R 2% 1k P28 T H1) AL A0 Se v/ A Bt 1 0 2 5 4, FE BE R 9
W B DL XML 32 o S b, A7 A a2 SCBR R ) 5 1, e A P9 2 SIS TR I A R 3% P 1) 1)
TR o T3 MR —AN S, 18 AR A A A8 —NRE s I AR AL, 2 2 T LY, JF ir
TR (I, g s 4 ) PR A FUASBEARA T Sk Ak 3R A5 FH 9,

[0221] s A AL RN s SCH B HERGRAF Py 28 20, LR BIAE R SCHEIR

[0222]  Hfd oA

[0223] A HE — NSt 9], 13 o B30 S 1) B I 5 5 2 B A P AR A T AT R AL
JiE, CAE AR 5 RE e n] SE M R DA . X e JE I Tl s e TN DL K AR s
PRI A R B A IR o A8 4, B P ) IR M TR A T S v AR R O ERE
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TENE R

[0224] 7 FT7n FEHEIA I Sl A, 3538 1 0 0 DL XML SR 3R Ak A7 78 A S0 28 28 7
(R A FERTAE A A S0 G R B AR 3

[0225] iR CEE B o AR B . BRI M g A — A s A B MR
TNo JETEE B TR AR R, BRI — B S A B 84S XML gname SRHGIR . &M T
H JE v B T PR R A S IR AN R R E A RE LR T R 2410 XML R AR AE /A S . 7E1X
—HHIL R, IR A A SE B XML SR ABAT o« 245 e, M4 9% T FH 7 2R 28 R0
BT 200, (B2 P Rl MR e 8008 8 PEASE R f ] B vk 25 2

[0226] [ A 52 SUB AR @ FALHI LLAR A — PR 2 10 2 SR AP A8 A ML i 47
[ SCRYAZ O R R o IR SESORYAZ O 8 T8 F T30 SO, s s S B - VR %
18 M.

[0227] 5 J5 , ¥ YNIX L8 SRS A% 00 8 T 1) 0 5000 38 1 AR TT 28 40 B SORS A% 0 B 1k 22 A1 1 A
A e

[0228]  JUELHE#%

[0220] A G AR B, HIR PR TG HoAT 22828, F HAR B DU R ¢ RIA 2 B Ax -
[0230]

| HERETEERIHAN | AR EXHEE FRAEERLERYE
3R 1 70 ¥ & #1F B9 !9 | application/xml-SimpleTypeProperties-PLACEHOLDER
BREDAR: P A 2 xR L R B JR k- 5 AL 5D
HRAUBRETHE | £ GG
X R A B AR IE A
BRI ABFRBIAT AR
PAFEIR M O EIE E A H | *F & X Uri B2 [8]* | http://mccf-DocumentCore-
HREIRRE BT PLACEHOLDER
B _ Chttp://mecf-3C R4 4% 0o o

AL

a7 LA B n B 98 E 4 B 4 | BRR 05k 1
RETHEBEGOHE

| AT RAR:
] Bt hn A B B F R 4 5T | TR TR
B3 FR A 1 IR B 4 1 B
ETLE:

[0231]
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[0232] LA XML A KM — A Se il 1 R IR e o« R TR B — 2> BRI
TAERED SR RS TP 4 o

[0233] <mcs:properties xmlns:mcs =" http://mmcf-core—services/PLACEHOLDER”
[0234] xmlns:xsd =" http://www. w3. org/2001/XMLSchema” >

[0235] {mcs:property prns:name =" property name” xmlns:prns =" property
namespace”

[0236] mcs:type =" datatype”

[0237] mes:multivalued =" truel|false” >

[0238] <mecs:value>...value...</mcs:value>

[0239] <{/mecs:property>

[0240] </mcs:properties>

[0241]

Frid & ik

xmlns:mes =" http://mccf—common & T MMCF 7~ FH IR 55 4 - =5 )
—services/PLACEHOLDER”

xmlns:xsd =" http://www. w3. org/2001 |E X T XML & F 26 W E XK
/XMLSchema” JEVERI SR L R PR 2R W T
XSD jE MR, REF BT AR H
H L4578 ], AR XSD 44 5725 (Al g iUE

TERRR PR TCHR XML AR E.

mcs:properties A VETCHAE XML FIR T E

mes: property EtETR. BHICREYEN qnane FI{E. 7]
DA TLREENEE TR, BRI 2
WTRMEE T TR,

xmlns:prns BT ST RZ OB, TR

http://mmcf-DocumentCore—PLACEHOLDER.,
B P e e, © A B E LA

prns:name JEa A EEA TR
mcs:type =" datatype” P R B RS Y e X AR g M,

i1, xsd:string

mcs:value o ERRE TEEME. HuREEHITEN
BT . R ned:multivalued =" true” , |

A AT ERRBER B U

20



ON 1961304 B i M B 16/81 T
[0242] ORI JETE
[0243]  DUR R AHEEMEA e SRR IR 1) SCRRZ O J8 PR A%
[0244]
2 Ei g
Commnets string. [T, BAEH | EFEFBHBEAN IS, X
AU SO R EL
Copyright strings A[fEIE. BB{EH | ZSCHERRRO
EditingTime int64. ARG, HE | HEECHEAERNEE, AR
e HNABFEZEERE. ZEY
AR EIEEL.
IsCurrentVersion boolean, FJ{Ei%. FBAE | FE~1% L0 &2 SURIHY ST R A G &2
H W A& . % F B AN
VersionHistory 5 H, {HA S HiE
AIEER BB
Language keyword(=string256)~ T] | XHHET (HE. EBE) . &
1Tk, Z1H FRENHAEFEZERE.
RevisionNumber string. R[{Li%E. B{E SR EEAT
Subtitle string. ATAEIE. B | SORIBIRGEURBR IR AR L
TextDataProperties | TextDataProperties « 7] | W Z AR A, MiZzBEHE
1%, BIE XTI EERES, M
CharacterCount | int64 | &4, 1T 4%,
LineCount int64
PageCount int64
ParagraphCount | int64
WordCount int64
TimeLastPrinted datetime. AIAE¥E. FE | B5 —UGTEIZICE R B BRF0 AT (]
Title string. AMTiE. BAE | ADIE SCRYTO N AR T E AR B SRR
Ao XAFRTESEHXHNET.
[0245]
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TitleSortOrder string. AJ{TiE. B{E (B SRREF (Fl, “The
Beatles 744 B FH 722K F“Beatles”,
WEETTSH “The” ) .

ContentType Keyword(=string256) 7] | BB HIRFZE W E K USSR A,
fFi%. Z1{E A E R R R BN 2 B iR A

“MIME 2% (mime-type) ” . i%
JEHE X T LSS A Y 3OS B A 2K R
HERAUEHFHEN.

[0246] 4 FEAEAY

[0247]  WFEEAYE T BEE NP EAEHOR S M. SEAET =AM - BE
B LA B A E . K6 ot 7SR TR DLAT WA I 455 2 R B 52 2 R 2 —
AN

[0248] EIEMEIE N B EBAALRERI L. ET 20T, F1E 0] DACERE R 3 /E
) MAS Hb SO R G R Y APT o X HERR b BT 1)

[0240]  HATH, 3 W Pa s 'S 2 WA A0E ik B — SR B IR P S4B ESEAE o A, X — AR T
PSRRI R B AE R & 25 A & T SN R R A o X R BRI 15 i), IF B i T 0 0 E (s
RRAE (JUHR IR NG R I 8] ), e R .

[0250] 4 S/ se KT e o 4 BRAL BT 00 20075 i = AN B BN IS < U7 MR =X AT =)
FEAFEEHE R

[0251] T FER

[0252]  JALAVHEE

[0253]  Fh 455 3 e 132 o 2 TR) S FH IR D9 7 Il (03015 AN ik I 1), BRI B 2 () 2 e v B
(R AT R BRIV #E o LA, MK BEAS S 18], HE AT T ) SR e et i e v P i & AR
[T L R A AR L 2 /T, S e B B s (e, S60F ) I 46 ff R I b BE %%k
o X He IR AT AE .

[0254]  JiaAEg

[0255]  HH5EFHIMHAVEAN, & A DL E ST IIAN 4 AE A — 1751,
N R A6 R4 4T BNt SO AN, BRI REANENE A 2 /D R BRI . 1B —
i, RS A LA A AR R TR P ] BECVE R BN ZI R A £ K, sz ik LA 2 DK
F-BIERRAER T ERE. WATREEEE, WEAN AR REEECKRNM T
HEE M Jash ARG & (Han, H5 # DA E SRR 4605 N P e e
HZEATE) o 34, PIERARN Y RV B E E A IE IR R A KRS O T GBS
IR R RO 2 A [/ DS S = W] 2:98

[0256]  [] o] 1] 2 R JH 4

[0257]  {EE B AR R G, TR BN 0H FE R 0 € AL RN A2 it
Py REAL I, SR B A SRR T AE A] AEAR S T T HEBH B o SR, £k HH S P Y
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BB E TR BT B AR R EH0 T I AL , HE ) 2 A S [ I B AV A
[0258] A JAFEX

[0259]  WEEALAAAF RIS o IXLEFFn] A PR AT 2 — kAT R < ] S HE e F AT
K HH 7 SR, A P R e SO KA o 4 LA 2 M 77 AR S AL R AL, LY
[R5 —F T AR BB R fa — AN S I T A SR BE, AR SR A
FATRNIA, f

[0260] R AZEEAG Ry, 2 A I 21T SR A AE 11, X AE FE e ol i el gk i bERE. A
ATHE A 2 SR AR AN DA 2 G R [R50 4, TR] B A% 028 AARH 2 400 ) A P R 5 U 5 |
(A, AR SO R I R IS ) o

[0261]  AZEEIE I TR AZ RS H AR (0 N 28 IR IR 24 0 SR AL B o 8 el K 8 A o 3 B B I
ACHIR L 7 B, PR IA B BB RS R 45 AL, [R5 ] RS S 1l o B s R B T A o Ay LA
AT 2 W AR, B 7 - 79 S AR () i 52746 ccontent. xm1702 F image. jpeg
704, H5—#F content. xml R T KA, I HARIZ O A RS2 X A4 HERAE 1% 00 L 1)
K% (image. jpeg) 5.

[0262] S 3EMRAZAS AT SR OMELRY , 25 S el 48 A a7 S HE 7 78 0 Y HE A i A8, ] 8
Fizs. AbdzA (G BB ) B e e BB A 1 content. xml #i4FLL
image. jpeg Z R ILIE R /R o TERLCEOLR (1 dn, /N By 50 1) A, BbRosIE (3 B % )
XA BEAZ M. EH SRR T (Ha, iR content. xml HEH KEE B EFERAETT ),
W5 B 58 A 1 content. xml FF R 34T BG4 T BUA AT H32 I 1 Re Bl B9 132 % R 48
FE AN BRI A7 85 7 K o

[0263] 4 SERLITFAKIVERE, BB 43 F) content. xml HAFI¥ image. jpeg #I/F4E A F
i), B I HE v Z AR R R . 3K AR v b 152 2 B8 e af b 2 45— B a3 5
L BUE SR SR AE S . 040, X8 7= A2 9 BToR b A fey o BT PERERI 25, 10 1 24 3
S FEAC T o AR A A BRI 2R A, ] LIS RR AN SR A o AN R A 3 A ] AN [R]
A PEATEE N BB RN o ANE Y ELA W] A PEAT Y , BB 0T, A R AE W ELE E IR
Ak, I ELAE o ) S 3 SR B 2 A BE R A 2 — AR s v BEAR B A i A
[0264] JEAEFEAX

[0265] 455 35 [ 132 [A) (0815 AT DA 130 2 00 G A 126 B e 0042 10 i L7 Il ke
BT, NI SRV EAIAN LI P2 5 1] o A8 FH 3o 618 15 1 2 WA — N B e 55 18 A A 2 s
KXMRE . — M5 A SRR AL 15 . WA DR AL % . S FRe Rl L
7 IR T A5 P () T RN ) B R S FEREAIL T 1] o HELCA 0 T PRl AL iR P i
(an, A FIYEH SRR HTTP 1. 1) o ATEAY HIX SS B 8 I fir i Kk RE, HEE A
SCREBANLYT ] o ZEBRLDIX—SCRFIE UL T, D 3 ] s M2 1 , B B0 e AT 75 B 1 i ot
JrHufE I .

[0266] FEp

[0267]  @HEA0e A e T A G s SERR R IR TR R e YRR . e
AT LA b B 3R RF Ak 2N DL R & Py (49, 5 T I I P8 ) o s i XnT DA
TR A WA G A A Y (1 3 i IR 22 A B AR T B o BB ARE AR SR g v Y. 224 5 A B
LA B AL SR IEARY o R SR AU E AL E— S, TR 2 T R 4. AL mT L
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HIAR OO RIEE A Z1P SO S A SO B — e s B Sciti . AT FERIM
A RIS FE L% SR, B s BN RE P SCFF o

CN 1961304 B b

[0268] WIS 7) &
[0269] WM N LU 7w T Wl o Bl iy R AT IE Y, JF B 2
A P BEAS SCHRFIX LW AT 2R 1) 43 o
[0270]
pap ik TEB A 4EE
Name s RE
- ContentType RRBEESGTHIA | BE
BEIFR
PartContents EEBERERAR RE
[0271]
[0272] 3 ISR A
[0273]
StreamingConsumption | L FlIE & AN 2K | Wik
Z T Hh A B AR A
StreamingCreation AHFBEEHFEFLERMIE | THEE
PR BESHMABERER
TRE4EIE
SimultaneousCreationand | St it 3 8/ 2 F i =X ¥ #8 | W45k
Consumption ER—aER—NIRE
SimpleOrdering BHELNRFEFHERS | ek
A AR f N+1 KIF T Z BT B
Interleaved ENMBERFE NS e
SequentialDelivery WM N KA AEERYG | TS
B N+‘1 Z SRR A :
Random-Access B 52 & B AN UG B IR P | TAEE
EREARMEE

[0274]  AFAEVFZ WD BEAF il A% 3, JURFRE A 70 1 5 A A A ) BAH UL E . 7278 UM ARAEE
RIS A7t % 2 TR R I, ] e T SR M A A R R B A T ) PR AR AT R AR AL
T o RS AE FE RSF F) J2 R S TR B fit A P AN AT A AE B BTN BE 7 o B, By A
PRSI BB 47 0 SO R G B3l SCPF o DA — W 3% 2, R F 22 01 A EL ek
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55 I R ) BRSO 28 A BRI o A8 FHAN A 00 R G SO 24 W 5 B 4 ] e e
TR A S o

[0275]  TEVF 2G0T, AN [FIA ALK RSB 38 ] BRI B AN 2 2L [ ot o) . 23 HLt
SF Il L R PR A 7R A0 R R B B A 2R B 5 8 A AH DQIBR IR, DL B4 SR A B A A S 7
Ao AU B AL T ORX S o S ] ) A AR 7 5o R I FE AL AE K ]
DA Bl (8 A B SRR Ad A Ak s R 23 LSS At e 77 6

[0276]  FRILEAF N A

[0277]  Wyifuks s e T H FAEE B — AR N BRI SEeed s dg R
AT RN BERA G ANIHLE] (B0, MIME H ) “ Content—Type " bRl ) o Xf TiX 4b4 3
A0, HEFEW TS F AW IALHIR R R AR P AR X e W kg o, A R L e AL
SRR N AR HEFERIH T 3R R 1 LA Hh 1 Py AR 2 R L 2 20 o A PN B R S i 44
(1) XML 3, B RANR . ZIRAS AT, I BRI A & A2 URT m] s hkidr. 4R, ‘&l LA
TEY) AL YA FH T T A8 B AR A A R AR A A

[0278] RMFAE S HATIH “Types” LR UL L —DEKZ A “Default” Fl “Overide” ¥
JCE M) XML. “Default” JoEE X T ME &Y R A BN AR R EA L . X R T 3¢
PRy 42 T8 0 N T AR 52, “Override” J0E T 2 AP BRI BRES 78 25 84
5B — B RN AR, BB EHEEH “Defaul t” o Kk D B
“Override” JLEMERE, (LA L E ML,

[0279]  “Default” uHEHAAHLLTNEM -

[0280]
Extension W2y 4. “Default” oYy &
A2 7 DIA) i DL A I i ik — g
8 25 A AT AR 044 AH VT B
ContentType RFC2045 g LN ERM, Fan |2
AT VTR P AR (BRraEd
“Override” JLEE i ; WL F3L) o

[0281] “Override” tEEAF U FNEh .

[0282]
PartName w4 URT. “Override” tEHH4YL |2

FEETRE A AR UL A .
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PR ok T

ContentType  [RFC2045 F15E XA &880, $5/RIC

FD

i B P AR

[0283]  DAF RS IERMF P XML BJ— D7) -
[0284] <Types xmlns =" http://mmcfcontent-PLACEHOLDER” >

[0285] {Default Extension =" txt” ContentType =" plain/text” />
[0286] {Default Extension =" jpeg” ContentType =" image/jpeg” />
[0287] {Default Extension =" picture” ContentType =" image/gif” />
[0288] {Override PartName =" /a/b/sample4.picture”

[0289] ContentType =" image/jpeg” />

[0290]  </Types>
[0201] DA R RAG R H T3 0F S H i BB 2R A R 8 RS I N 2R 7R 9 51 =
[0292]

W A

/a/b/samplel. txt i A ) SR

/a/b/sample2. jpeg K& /jpeg

/a/b/samplel. picture|E14 /gif

/a/b/sampled. picture|E1% /jpeg

[0203] X TPy iy — &, RS LR —A : (@) — M ILELH “Default” Jt
2, (b) — P ULECHI“Override” 0%, 80 (c) VLELHI“Defaul t 7 L ZE MUCHELHI “Override”
TLEME (X150, “Override” TRAMELE ) . — KI5, XME—HERT R4,
wEZH A “Default” JuE, I HXME—4 2 R4, mE2 A1 “Override” JLE
[0294]  ZKAUGF “Defaul t” fl “Override” LR MIMUT A2 EE K. 2R, fEAZH A,
“Default” 1 “Override” JTRAEVELEL H HILAE AR BB AF 2 A1 o

[0205]  ATHH

[0206]  FFAEPTA K HE A AN S R A BRI AT . 72— St b, 24—
TEFE ) B AL R S AT 1 AR o s (0038 R L BL ARV BB A i A2 4 o 308 FHATL il 38 a4 3400
1 BB Lo B ] 5 e AR BB AN S AT 1 2 A BOR TAE » B
BUAE B T AR AT, IF HARR R A At AN v e IR . Bl HA F K

[0207] & ST LA AET 44 BIREAE KA A B ) 44 - IR E — i i, 46743 P 52 4 A BA 4 L
JRLE BRI P B & A — B LUB e A i s I o

[0208]  FH -3 Hh 45 #iF 44 B BRAG TR -
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[0299] piece name = part_name” /” 7 [” 1 * digit” ]” [” .last” ]” .piece”
[0300]  DARA ML AT HZEE L R piece names /Z1E

[0301] @B S LLOJTLA, JF HE2 EM IES MR, B 9n Ly A2 FHR
(left-zero—-padded) »

[0302]  @ER/FI A BUAENI B G — N BB S B AT “Lpiece” ZATHI “. last”.

[0303] @ )7 B 7E W B AL b 1) 44 7 T AR AR I 48 A

[0304]  JEALE DL B ARIUTAE A7 v B (HE IXAE A TSR AL I 3808 . AL
OB s T A B AR AT A (R B ) S04, BRI LR 7R 2 A 20 -
[0305] spine.xaml/[0]. piece

[0306] pages/page0. xaml

[0307] spine.xaml/[1]. piece

[0308] pages/pagel. xaml

[0309] spine.xaml/[2]. last. piece

[0310] pages/page2. xaml

[0311]  'RpsE WS

[0312]  "R3C5E ST LA 3 e € WL Windows UM FR 48 1 IRA O

[0313] 3| Windows 3CAFZ2 48 P HIAR BT 1 W SF

(03141 Jhy SE 47y B foff G Ao 322 B A6E 2 1) T 2R ST B A9 BEAK 5, 25 T8 Metro B3R 7R 4
Windows LA RS AR HCCF SRS REEAG L. 1ZHRA T & — SR A & 7R 5l )
A G W BB P R — AR A A2 0 N T30 4

[0315]
EHyE W R
A SCAF
A4 HA BRI (N 9B L URT BRSO AR AESE ) o

AAFN SRR (RS RIE SO AL S AR RIS 1) g B0 472 (1) XML

[0316]  HBAF44 il e A A1) Windows SCAE4, T LA Ak s i o
[0317] N LA HRERAD TR, A T2 B (URT BY) M Windows CF4 /&
AHHN . SZREER TN EEMHNE
[0318]  AELEPI AU URL 555, B'S () FUES (), 784 URT B AL Rl ST 144 ) 75 S0t
EMART 55 Lo
[0319]  (FIEAMMICMH2ATS ~ O D# gL, URL 230 (e H TRk B B
1), anACHT ) o
[0320] %% L7 FIAEAE A 4460 B AN BEAE SO 44 A I 245 I 7= AR RO 4 TR 1Y
BR . AR5 A TR 5 O), H G ERBE A7 1 /S ikl R R .
[0321] 4 M abs_path ( #{F44 ) Wit IS0 /F4 -
[0322] ¥ 5EMIRR /
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[0323] G PTA ) / A\

[0324]  X'H 5 HIE T FERFEH L

[0325] 41, 54444 /a:b/c/d*. xam]l 25 A DL 44 a”25b\c\d " 2a. xaml .
[0326] DA PhAT S Jm) IS

[0327] ¥ PTE )\ Fetb ik /

[0328]  [n] Ef IR LGN N /

[0320]  J@ ik X AR5 4 [ oS iEHIARRE ] X254 S (unescape)
[0330]
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Flhrs
B~
iy +
=l
edf H %

B (
& )
L
EEH -
& X0 i
=
EHACGES
A
2k [
B ]
SR rAc A
YY)
AR
(&16d) =W
SER I

CEHV LMD B s | LigfeL

:% :7 :@ \; :_u :7 :O \; :Q :7 :,m i

_ | :_ | \; 4 :7 ne; \; 24 :7 v \;u«wmﬁ_u”x@:

Xoyxoy , 9% :H@@Qmom@

:A iH

7 :v :_ u" =_ u* oy u" u u \; :. :7 :\ \; " :HvTH,mE
1131p 7 eydie = mnueydye

yreu 7 mnueyd]e = poaIssaaun

i ¢ :7 :% :7 :+ :7 "— :7

4B \; ) \; ut :%@Qmomﬁwm\i@mgcsHiwsog

Jeyody — meJged

(weaed t ) xJeqods — juouses

"

(yuemdes |,/ | )x)usmdes — sjuomidss yjed

Bk
L B R 00 4 2 B 0 i

(96£20.0) [0 WA TN EH 3K

AR 78 1

[0331]
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[0332] S B AREIE —AF, PhAL L R T AR I sk g e . X — e R —
MRS TR T — R B E MBI RS UL AR AP S MR RS S
RAR AR SR BB i vhRI o SBIHE, ZRYE AV AR = 7 A HZ IS Y . X — 3 R W] LA
W AR VE AR 78 73 R B — R e AT EDATL I REAE IR SR, [RIINHTS 447 5 AN RN AT EPALIR A7 AR
[0 e ] B e

[0333] i Fi [l 5 5 20 60 250hn 30 ARDH AR AS Bt B30 1 58 = 7 7 8 AR SRS R ) 13 3 4T
KFAT R (o, v A 2R RELE Y 2% ) B0EE Y P, AR S s, SCRIIPE®E (-
A2 OZ ORI TR ) R4 S 8 B R U e 2R B PR B 5 AR S AT A . AT E
SR, X — Rt S R E .

[0334]  SHTIIHT EATL D0 U 28 A0 HL & 20 P ML AT SR SR SRR AE 1R 5 P SCRF o A Bhi AR B
PR () SCRYAE 5 011 40 b 25 FEAN S0 HS e F R A 19 B 152 (AT

[0335]  FfuARfb 44 7% )

[0336] XML bric I3 T4 725 0] URL. R FT— XML & 725 10), 828 1 i AT 1
XML JG 25 LA J2 %48 28 () A e ) XML J 1, SRS RO ArT A< 1 o 2 SR 5] 15 3 AN TR0 3 1) 44
R[], M) 13 T BT SO rh e e 16 5 B 2 IRERAE

[0337] XML 4% £ %% i) URT “http://PLACEHOLDER/version-control” 44%& H F 43 [fi 52
AN XML 7o B AE M, AR 102 RS B IS NI IE M. [ e A A A
AL P BN ITE . AR, A B IE NI 2, DA <ver:Compatibility.
Rules> Fll <ver:AlternativeContent>XML JLZEHIE/D—1 .

[0338] IX —[H @ A A & bn id s H A 5 HAH ¢ B xmlns URT :“http://
PLACEHOLDER/pd 1”7, 7E [ 52 7 28 S 8 A FH 122 44 7 28 1A i s 3] s 3 I R I A4 FH i
e LTCER . SITER AR IRARK BAG H B CR8 7 75 1. BAZH 48 720 [A) 1) ) 152
B IR P 0 20 T ] SCRE ST AT AR AR e R T 2 B R B AR o AN BGRSHT IRUAR 1 1) 132
5N FHFR RS BT MUAS IR URT 2% FE i 26 PDL [ 3 — AR 4047 & 1% URL —FE o X L6y FHFR S
A BEAN KNG AE 4 2 A 2 AP AE R R, Bl — N — M A

[0339]  J ] 1 “Hif [r] ” e Ak

[0340]  FESZEFILAL AT I8 B R G AN 7 VA R AR B & A BE A, S 250 | 5 AL
A8 FH RIS 1 S BT R A SRRV (9 AR ™ i B AR B R () SRS AT 35 v 2 B F0 B 7R TR e ok
ferme SPRANHUHIRE L T “ 5 MFRANE”, VPR AL AR SR SEIL R0 S Rr T HE R
N RRRASCRY, W R SR

[0341] i a7 EPALEE O SRR 2% 2 WL 52 BAE T AR 10 18 & 10 RS IR AR A4 22 1) SCARY I
%% PIOHLBE X A P R IR TR TR VR M I E B E AT o A IRV A A TR AS B B 19 % S L
RS FH 280 T P A R A A P R SRS PR 6 T T R A BT IR SR A BT R SR AT
HER MR SO B IR A “ IR F TG N

[0342] b4, BT SR P HIAR TR B8 S RF A Ron s = BUB MR g B 1Y
SCRY, PRGBS i S “B T BN 1) SORS B B — A o

[0343] W1 IRFTENHLE SR G S B BRI &, & A % Ry 4 H— BB RE
B AR G T B IE L SIS N AR S o X F I8 N S BRI Y 2 oK
e eE M. AR, BN IR, AR 2R AN A . 82 e SR
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BT B N 0K A i AR U B FE AP A B R A 1 o SRR3R 5, WS
JEXTBRAR N B RFEARN . BIRMCE B IS 25 H P

[0344] Ny SCREFIX-— B, BRACTE & WA R RRAS Y 238 58 204 4 725 R A
KA. L7 3K, SCRYAE 2 RS A H S DBt 19 4 7 2% TR R T IR AE

[0345]  fRAALFRIC

[0346] A T3CFFHHE BIENAT A1 XML TAVCALHE L0 -

[0347]

AL TCF N I3 R H5 ik

{Compatibility. Rules> FEHIVEAE 73 T8 BT 0 R 0 o 2% B P S o

{Ignorable> 75 A SCIRI) URT 2 ] 2011
{ProcessContent> 75 A0SR U R A 2, ) T R ) N AR U ) R

Koo s [ A 5 A R AL B

{CarryAlong> 1] SCAY 2 e T HL TR 7R S ORI 2 B Y Y (R A7 ]
RIS TN 2

{MustUnderstand> {81 4% 75 BH A ] Z2m& ) JE 2R AR

<AlternateContent> TER AL / 37 R AR IE

{AlternateContent)> JGZ B A REAL R4 8 2 R
Prefer [FFRIC I 15238 B H R P48 18 AR

“fallback” Fric .

{Prefer> BEBEMNNE. ZNRLEPPIFIERRA /3§ R
RRTE

<Fallback> WF TR HL, Fig T BN AR I
g

[0348] <Compatibility.Rules> JLZ&

[0349]  Compatibility. Rules W] LAk B 21 mT 25 4 B I i) J& ok A — o 3= b, Wb in 2
Xaml fR7CE bo <Compatibility. Rules> 7G5 #4173 B 4 W] Xof AR S oo 22 B M
o SR & AR . 7] Compatibility. Rules J& AN Ignorable Juzi@AN T
iAok B L0 A o TR IR IR e 2

[0350] Compatibility.Rules 7] £ & JG % Ignorable 1 MustUnderstand., 2R A H:, BT
H 176 2 M8 ME R 2 b MustUnderstand., JG 2 g 4 a] LUE ¥ Tgnorable JC & W
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I B H AL Compatibility. Rules J& PE 12k AE i Tgnorable, JT 2 B 1 W] LLIE i #
MustUnderstand JCE ¥ I B B A48 — IR K MustUnderstand, — Ignorable
g\ MustUnderstand Jg[7]— Compatibility. Rules JCZ& H I B 44 F 40 URI.

[0351]  <Compatibility.Rules> JUR RHAALRINI A, MAEAA B CHRIARZEBUE M. A
Wi 25 A AR 2 B 1, SEAR SR AL S e A TR . Xam] MR T E W] H T 5% 7 4 T
EIJCE, U Canvas FREHATEMM] . Compatibility. Rules E& B RAAF I —IT
o

[0352] <Ignorable> JGZH

[0353]  <Ignorable> JuZ B T A& 14 2% () URT @] ZBE (1) 40 A AT sl
AP TEIIET 7 75 8 T <Ignorable> br4, 3 H. 44 25 1A) URT A2 73 s A2 AR EN 1, W
IR 2 T] 2SR i URT 0, W] A3 Ab 3 Tgnorable 28, I H P (1 AR &
PRAARI) o AE— S, KA EHEA 75 B4 Tgnorable W FTH T4 Ff# . Ignorable Jo
FH[ A F ProcessContent> Fl {CarryAlong> JT 3, BATH & Wi 2% 76 % DL K R 3C
PG 5 T L 25 7 N4 AT 76 B R SR ORAF IR B I R IR =

[0354] <ProcessContent)> JLZ

[0355]  <ProcessContent> Ju% /5 B 1 WIER JC 2=l 25 , W) T 2= 1K) P 2500 i [R) e ph ok 20
[RITCER A A AL 3

[0356] <ProcessContent> &k

[0357]
JE M P
Elements X AL N R T 5 4 B S AR AR, 5lE 7 1)
NN A AR BRI T TR I A . R AR e, WOt R )R
PEERIA A “%7

[0358] <CarryAlong> JLZ

[0359] W] fEiL ) <CarryAlong> JGZ [n] SCH4 J e T H 4578 2418 B SCR IR 2 45 B 24 fR AT
A ARSI A SndE T B ARAF B 57 0] 208 N A I ik e g ds T b, ik 24
{CarryAlong> JuE a4 7 I I [F— o =8 g Tk, Ws @ M f5 — 1> <CarryAlong> H
AR

[0360] <CarryAlong> J&

[0361]
Je Tk EripaN
Elements G SO IR I SRE [F] - AR L R e R A T 22 2 S A
e Rk v Sl LI S0 TS vy D | SR e VA F ) i 5w 8
UAR AR SR E , WTC B MR “*7
Attributes JUE W AR IR T 4 B A% 2 S 1) 3R 8% $Ro
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J Tk ETHpaN

TCRMITA RN AL . 2 u R g IR AL I,
PTAT IR e R A3, I ANVEZ R PR N A . 2R g

(¥ g PR AE AR A M 1) T8 2 P AR S 4 STz 4 R S, T
HizBEEA SR BRI “x7.

[0362] <MustUnderstand> JGZ
[0363] <MustUnderstand> Zf5|%% Ingorable JLEMMRIKITE . Hin, Y E5FH N AL

EL, IX—HEARRA AN, £ MustUnderstand> JoE & LITEHISF, JTGRRFFE Tgnorable.
[0364] <MustUnderstand> &%

[0365]
JE 1 ik
NamespacelUri TG 0A 0 4k BLAA 1) 44 72 (R 1) URT o

[0366] <AlternateContent> JGZ

[0367]  <AlternateContent> JG2 fLVF U RFRE WA BIAE— &840 Ak PR WIS (2 e iy
7. AlternateContent HAFH T <Prefer> fl <Fallback> Ht, WIH <Prefer> Herp {47
AR BEAE, WE ] <Fallback> PN A . 472 M4 A B4 MustUnderstand>, LA
FRAREAT I JEIR o W SR 48 o [a) 4k 75 B A m] 228 9 AR <Prefer> HLrp i ] 1 %44 F 45 [H,
W ASEE ] <Fallback> Hidh (i py 2%

[0368]  fRAALERIC S

[0369]  fdTH] <Ignorable>

[0370] AR H TR AR I bR id 44 - 4% 8] http://PLACEHOLDER/Circle, & & X T HA)
WA JCE Cirele, I H T 5IABIBR G R RRA (B4 2) i) Circle ) Opacity
JE I, LA I ABIFRIC I B IRA (/A 3) (¥ Luminance J&ME. iX—FRId7EMRA 1 A 2
, BLK 3 RHBE 5 AR AR FE AT INE . 34k, <CarryAlong> JURTRIE T Admfn,, HL2TE
grdE 2 AN FEAA v3: Luminance I, A {RAF v3: Luminance.

[0371] X ThAs 1 [EEE, Z0% Opacity A Luminance

[0372] X FRRA 2 [, 28 Luminance

[0373]  Xf TRRAS 3 A UL I RRCAS () 15 132 A4S0 FH A 1) g 2k

[0374] <FixedPanel

[0375] xmlns =" http://PLACEHOLDER/fixed—content”
[0376] xmlns:v =" http://PLACEHODER/versioned—content”
[0377] xmlns:vl =" http://PLACEHODER/Circle/v1”

[0378] xmlns:v2 =" http://PLACEHODER/Circle/v2”

[0379] xmlns:v3 =" http://PLACEHODER/Circle/v3” >
[0380] {v:Compatibility.Rules>
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[0381] <{v:Ignorable NamespaceUri =" http://PLACEHODER/Circle/v2" />
[0382] <{v:Ignorable NamespaceUri =" http://PLACEHODER/Circle/v3” >
[0383] <{v:CarryAlong Attributes =" Luminance” />

[0384] {/v:Ignorable>

[0385] {/v:Compatibility.Rules>

[0386] {Canvas>

[0387] {Circle Center =" 0,0” Radius =" 20" Color =" Blue”
[0388] v2:0pacity =" 0.5” v3:Luminance =" 13”7 />

[0389] {Circle Center =" 25,0” Radius =" 20" Color =" Black”
[0390] v2:0pacity =" 0.5” v3:Luminance =" 13”7 />

[0391] {Circle Center =" 50,0” Radius =" 20" Color =" Red”
[0392] v2:0pacity =" 0.5” v3:Luminance =" 13”7 />

[0393] {Circle Center =" 13,20” Radius =" 20" Color =" Yellow”
[0394] v2:0pacity =" 0.5” v3:Luminance =" 13" />

[0395] {Circle Center =" 38,20” Radius =" 20" Color =" Green”
[0396] v2:0pacity =" 0.5” v3:Luminance =" 13”7 />

[0397] {/Canvas>

[0398] </FixedPanel>

[0399] f#H MustUnderstand>

[0400] DL R7RMBIF B T X MustUnderstand> JC 2 IA# o
[0401] <FixedPanel

[0402] xmlns =" http://PLACEHOLDER/fixed—content”

[0403] xmlns:v =" http://PLACEHODER/versioned—content”

[0404] xmlns:vl =" http://PLACEHODER/Circle/v1”

[0405] xmlns:v2 =" http://PLACEHODER/Circle/v2”

[0406] xmlns:v3 =" http://PLACEHODER/Circle/v3" >

[0407] {v:Compatibility.Rules>

[0408] <{v:Ignorable NamespaceUri =" http://PLACEHODER/Circle/v2" />
[0409] {v:Ignorable NamespaceUri =" http://PLACEHODER/Circle/v3” >
[0410] {v:CarryAlong Attributes =" Luminance” />

[0411] {/v:Ignorable>

[0412] {/v:Compatibility. Rules>

[0413] {Canvas>

[0414] {v:Compatibility. Rules>

[0415] <{v:MustUnderstand NamespaceUri = " http://PLACEHODER/Circle/
v3" />

[0416] <{/v:Compatbility. Rules>

[0417] {Circle Center =" 0,0” Radius =" 20" Color =" Blue”
[0418] v2:0pacity =" 0.5” v3:Luminance =" 13" />
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[0419]
[0420]
[0421]
[0422]
[0423]
[0424]
[0425]
[0426]
[0427]
[0428]
[0429]

{Circle Center =" 25,0” Radius =" 20" Color =" Black”

v2:0pacity =" 0.5” v3:Luminance =" 13" />

{Circle Center =" 50,0” Radius =" 20" Color =" Red”
v2:0pacity =" 0.5” v3:Luminance =" 13" />

{Circle Center =" 13,20” Radius =" 20" Color =" Yellow”
v2:0pacity =" 0.5” v3:Luminance =" 13" />

{Circle Center =" 38,20” Radius =" 20" Color =" Green”
v2:0pacity =" 0.5” v3:Luminance =" 13" />

{/Canvas>
{/FixedPanel>

% MustUnderstand> Jo 2 #2006 v3: Luminance 5| H &%, BT & R

JCEHHE A Ignorable. 1R S5 4F B ands N2 Rk A 2 ¥ Canvas 1) Luminance J&
PECORSC) MR N AL S, WX —HARRA A, 76 Canvas JTENTEHE AL, Circle 1)
Luminance J& M K A2 7] ZBE o

[0430]
[0431]
[0432]
[0433]
[0434]
[0435]
[0436]
[0437]
[0438]
[0439]
[0440]
[0441]
[0442]
[0443]
[0444]
v3” />
[0445]
[0446]
[0447]
[0448]
[0449]
[0450]
[0451]
[0452]
[0453]

<{FixedPanel
xmlns =" http://PLACEHOLDER/fixed—content”
xmlns:v =" http://PLACEHODER/versioned—content”
xmlns:vl =" http://PLACEHODER/Circle/v1”
xmlns:v2 =" http://PLACEHODER/Circle/v2”
xmlns:v3 =" http://PLACEHODER/Circle/v3” >
{v:Compatibility.Rules>
{v:Ignorable NamespaceUri =" http://PLACEHODER/Circle/v2" />
<{v:Ignorable NamespaceUri =" http://PLACEHODER/Circle/v3” >
{v:CarryAlong Attributes =" Luminance” />
{/v:Ignorable>
{/v:Compatibility. Rules>
{Canvas>
{v:Compatibility.Rules>
{v:MustUnderstand NamespaceUri = " http://PLACEHODER/Circle/

{/v:Compatbility. Rules>
{v:AlternateContent>

{v:Prefer>
{Circle Center =" 0,0” Radius =" 20" Color =" Blue”
v2:0pacity =" 0.5” v3:Luminance =" 13" />
{Circle Center =" 25,0” Radius =" 20" Color =" Black”
v2:0pacity =" 0.5” v3:Luminance =" 13" />
{Circle Center =" 50,0” Radius =" 20" Color =" Red”
v2:0pacity =" 0.5” v3:Luminance =" 13" />
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[0454] {Circle Center =" 13,20” Radius =" 20" Color =" Yellow”
[0455] v2:0pacity =" 0.5” v3:Luminance =" 13" />

[0456] {Circle Center =" 38,20” Radius =" 20" Color =" Green”
[0457] v2:0pacity =" 0.5” v3:Luminance =" 13" />

[0458] {/v:Prefer>

[0459] {v:Fallback>

[0460] {Canvas Luminance =" 13" >

[0461] {Circle Center =" 0,0” Radius =" 20" Color =" Blue”
[0462] v2:0pacity =" 0.5" />

[0463] {Circle Center =" 25,0” Radius =" 20" Color =" Black”
[0464] v2:0pacity =" 0.5" />

[0465] {Circle Center =" 50,0” Radius =" 20" Color =" Red”
[0466] v2:0pacity =" 0.5" />

[0467] {Circle Center =" 13,20” Radius =" 20" Color =" Yellow”
[0468] v2:0pacity =" 0.5" />

[0469] {Circle Center =" 38,20” Radius =" 20" Color =" Green”
[0470] v2:0pacity =" 0.5" />

[0471] </Canvas>

[0472] </v:Fallback>

[0473] {/v:AlternateContent>

[0474] {/Canvas>

[0475]  </FixedPanel>

[0476] ffif <AlternateContent>

[0477] W RAT— o Z 88 4% 75 B o MustUnderstand>, H & 7E <AlternateContent)
L) <Prefer> Herp ANgh AR, B ARBEE <Prefer> B, JF Ui HukbFE <Fallback> Bt (R,
18 BT MustUnderstand WUAR & A E % ) o

[0478]  <v:AlternateContent>

[0479] {v:Prefer>

[0480] {Path xmlns:m = " http://schemas. example. com/2008/
metallic—finishes”

[0481] m:Finish =" GoldLeaf” ..... />

[0482] {/v:Prefer>

[0483] {v:Fallback>

[0484] {Path Fill =" Gold” ..... />

[0485] </v:Fallback>

[0486] </v:AlternateContent>

[0487]  ZIAAUAE S

[o488]  {ELL TRy, $RAL T X5 E SCAA% AR o A A ) 2 WD G/ b el A 45
EPS = BN DN SR Wi A e = Bee O 8 VARl DA SV GR:= i1 SN T DA=AR e Tae 2 i Nl [ ke
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AT R RB T DL« 2 ihRid s BB — AN B AN A S N R
[0489] X% A A2

[0490]  7E b SCHEIR T /R BIPEMESL 2 )5, DA A &4 A Bid T B AR e e i Uz
—o BRLRBIAIEAR, CLF ORI L T — s s X, AR SRR 2 SR AR 3 () AR % B
(I o

[0491]  AKHEASI ], AN R] A0 & 2 A R0, A — MU SO A R R 7R . AR
BT BB, AL T BRI R AR R R A A 2 A T 75 B BT A .
AT DL ORI [ 2 2Ros 1] R s R R BT R R R R

[0492]  DIRHEIRE T RN “ [l A8 8 ” e e R s . [ A R 8 B & [
SE TR 0 AR A, e 12 5 ) FH [ 5 DA o X e Rl T 2 TOSCR ARSI
[0493] gl A/ b— ANl A U, FRIEAE LA T 3 ) e B B R oA BA L. B
A Y 1) 123 A0 15 S 5 n] B B A S R E S B BRI 5 [ 2
[0494]  FIAHLFIRHIE

[0495] KRR BTk (1) S e, RIS BAR T 115 B TAEE X 70 & AR A 23 SO I 77 3K o
A8 FH 2000 S IRE I, 238, ] DA CRAE AT A% X rh B 1 L BH A b 73 A2 BCFT B, T e 7R
W2 LT BN R P40 2 BRI E R G BURE e 746, T RIAA 36 202
ST N R T8 R 1 5 Ok R IE 1, R b SCRY I TT DUAE 3 T B A 1 3
JRE DL REEE AT . ATRALX—B8 ), fERIA A P oI AN IR T [ 8 3 2 3

A~
tho

[0496] I ATt IR F S Bt 9] » ] A7 20 00 i AT I 250 i) 0, I HL 23 0O B2 A IR
[ 5 A7 2 g A b e B P A e B R AR TIUE e R — TORAT B RN 1) ks
ANSBEAEE e EHATAG RS, OF LA A Sy 2 BN B XA TR, i 2150
A, E AR E A R RS HA R HE AT RR R . TR A (SR EIR ) A
FLLPN EV-F Bk IRV e i

[0497]  RUIARLSCRFA] T LB I A& AL — 2 DTSR RG B £ S R[] 5 1T
W7o A TR IS 3 A A TAR R 2 OO . [E AR Je T ik — b S S A N - M
FIRIERE LI g “ R &7 ORI e .

[0498]  {EAT7R I IR IR S ), BIIE AL SCRE— MRS E MR (0210, Bk O (8] 7€ AR 751
] T SR — 2L TARORY G A A B SR VORI SR i, REERAE SR B ANTRIK
PRI SRR S AE 8 - O S i  aok (RE i ) Bk =+ iRk (e
TR ) o

[0499]  RUIARSCRFZ MR EE RS, AT Al AR B & AR A A IR o (1 SRS A
ARG AT . R A, P RV Tl 5 BUERE RN DI /e o H, 4, W] HA
T SO, e A P AR A ORI S TR R R AR s L R R

[0500] BRI #% 23 A1 e H1 0+ 2115 A i 4Lt 3K 28 g S ] L2 Ob, BB REVE I, B4
EUB b Eispeimyi A ib b e ¥ ils 7 M N BN E R AFE T DNINE ¥ ATS sy AR TP N P
KPR LSS A B AT A A BESE BB DIRINIAE B 344 0 “BIE A7 — A fase.
[0501]  F3 &b, BUTAAL a] A5 BN AT R0 8, EATIAN R [ e AT 2 8, M2 SR S
I HATREV] AR AN o IK SOV R B A8 G R A N TR P b A8 4 R =R 1 ] R
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SCRS S VA SASE L HERR I 1] DLEAN G 48 TR P B D0 R 28R IR

[0502] i), MRS, BITA RSO RE TR ROFT BN o FT B2 PRS0 T N S AEFT BN
A 0 VL o S BT B SR 40w DU 25 b B N DRSS B RS T o B, 3T B 2240
A LARE B I 2R, I HLIL BB S M HE A o 3T B SR IE w] LAE S5 P R BUR ZU00] 1
B oo, BB C) 5 I HIZ AT B S0 S AR ST B AT AT BRI A 3 45 1

ME G EE.
[0503]  FIIAfU4E 44
[0504] 4 bJTiR, Bk S — 2R AR, B0 4G [ 5 D 1 « ] o TRIAR « 2H B3 20 1 B 2240

SEAF . IXLERFAEAE A A ] R R D AR R B RIOG R o AEATY S AR SR
b RO TR R [ SRR , BLAE FTAT X LY A O AR A ST BV G A AR

iR,
[0505]  FIiAALLE MR
[0506] & 10 7R T — Dol R A, IF HAE SR 4, 7~ T ] 44 Al A sl fE A 3k

IR SO RE— AT R AL P SCR M RN I T R R 2R, IR 9L T R — N0
ik -
[0507]

[l 5 it B[ JORRF AR AN LY

application/xml+FixedPage—-PLACEHOLDER

S

[ 5 T
application/xml+FixedPanel -PLACEHOLDER

B[] 52 TEARCHZ N PR —
1 e TR 5 AE i

application/xml+Selector+[XXX]
application/xml+Sequence+[XXX]

FAK FARTT LR ATER Y, B
AR SRS ST AT S AR 0

K4 KI5 B A v AL FEAE

image/ jpeg

image/png

HERE A TEPEAR AT ] T

AR B, R R A
ZoIANBP,

R e s
application/xml+SimpleTypeProperties—PLACEHOLDER

g ool (s bR,
RBET) IR SRS AE
o

TTENS R
application/xml+PRINTTICKET-PLACEHOLDER

ITED SR AT BB AGAE Y DL
P k=3 T B ] e

38




CN 1961304 B WO B 34/81 7

[0508]  FH T RIIA LA B TE B AEATAT b 7 825 FNFT ER” (1) 3044, D8] i 2118 A 1y (5] 152 5 F0 4
B WAL ERAT AR T “H S BRI AR A . ARt a8 Bk
LI E S, T30 S TS

[0509] il ]iEE @ ﬁﬂ Sji

[0510] 3l A 20 A0, 2 W] A b M B RS G 0 AP S i [y L e bRk < I () 22 /> — A [
SETHM o A1 HE BT AR (S 9],  I aok R A LT 850925

[0511] @ AL TS A 0 it VA b 3 7 e PR A 1)

[0512] @ 4PN ATZE T i, 4S8 5 BIE R BIAHERGH A (LUR R ) BIHERGE .
[0513]  @7EIIIL e BT il o5 A (A R AMO RIS &)

[0514]  JXEELLuET AFe02 (I Gtem> 0 ) —ALBHR K BIIA G R A A B
[0515]  [E[ s &k

[05161 [ & 7 285 £ 80 FLRR A A2 I TR ARG T 4 R0 2k e o, B 10 R i i — [ e
A A B AE SRR ] 2 TR ASGET A4 by AR A o A 2% e i ] e T AR PR 2 Ak 3 iy
T AR e R A AL, IR A

[0517] @ [E & [HIMRAS &

[0518] @ MAJF] e AR P 5 | FH A [ o T

[0519] @ HIA A AE— B e T ( BEs0EEEREA R ) 5 B ra BUgR
[0520] @ M A% A7 25 P A — [ e O P A P %) P 5l L e B T 42 5 | I P A B0 T ¢
& CFXeHid) 5

[0521] @ HYA 200 A AT — [ 5 005 | I BT A 2 A A

[0522] @ B i) 3] s A3 % 87 AT — 4 1A B A s 1 e B A 5 LA %

[0523] @ B I3 [ e A 2 3 AE— S A —FT BV 4R .

[0524] I FIIA AL A 250 R

[0525]  {ESEMIMMIER T L X, DUAE G A IR T A 16 Sl 49 Fi ik < A 20 BIE ALY
—ECHER

[0526] @ FAALLAEA A IR R FIFRUHENL 2 LR

[0527] @ B4 LA A LU E B BT 5

[0528] @ |k AL 20 HA A A [ 7 AR I#) 22 2D — A BIIE A U0 380

[0529]  @FT B L4 S A T LAAE B I BT —HE RS A [0 5 R AR A s ] 52 T AR P B TR
B[] 52 LT AF AN SE T, X S i http://LACEHOLDER/HasPrintTicketRel 5<% 3k
SERLT 5

[0530]  OFTEPZZ4E AT LA B in 23X Lo 8541 i AE — A8

[0531]  OAT—4hE d LA A Z T — AT B0 4

[0532]  @FHIAR Ptk TCAICHR & 44 T LA B In 316 oy (A — 4

[0533] @ [& & R 5 E TR — AR S0 0« FAREAE” — T SR AR
LU

[0534] @ M\[H]E A 2 0 B AT — [ 8 TN BRI 5| 20 dR 1) (n] el i He e s e A%
UL ) AR HH Rk R H B R S B S R I B S

[0535] @[] &5 2 f A b A A A — RS A B D A0 e BRMGERAE” — 1 g U1k
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H RN

[0536]  @xf T M lE T ( BRsGl kg A8 ) 5L — 24 R SOE S8R 0T
WA NG I 72 DR | TR “ T BB A7 SRR (R AR % = http://mmef—fixe
d-RequiredResource-PLACEHOLDER) .

[0537]  SILHERRB AT

[0538] RV BIIA A AT A B VT 2 R AL HERSGR AT, AR T A B 52 SRR HERSGES A (1) SR AU 4R L
A HRAZ SR B 2 AT R o X L8 AT B e SCRRIAT R (R R A2 e Pk Ay 38012 HE FER
PFo AR T I 8 R AR 52 I8 AL A A0 I AN AH SR T o

[0530]  DAF HERSEB (2R 844 2 X ok BNk HER AR A

[0540]
e pusee ETHARESER R AIERE
application/xml+selector+language
PR IE A ETFEfRBEL AR RN LML
application/xml+selector+color B
PTI PN vt e T T H I KN ER IR Z A EFE

application/xml+selector+contenttype

SESE Ytk ST H N AR G R AR
application/xml+selector+contenttype|7~ [ EFE

[# 52 -4 B E A1 s SR AL T

application/xml+sequence+fixed

[0541] @ j£ jﬁﬁ%ﬁ“

[0542]  Hl e SCOM IR HERSGA A I8 S8 e B 28 HE RS- AR O B IS B8 o B Pk, o
SRS ETHARNES, s BUATRER R LR . ARINXIE T, L A L
— I, ANAEA XML (IR EE 04 25 JEAE N o X T I SL i, i A — IR o &= DAioe B 5 .
WA xml: lang J&HEAAZAE, WIZBS LT EREAS IR TR TG IR IR B ) B — A, e
Hit T 5 RS MEAE S AR RS — A

[0543] B FELSIE T EA 2 B A2 OIE RN LR TR/ Dk Reds 2t T T
[HR/NMER R Z RIEFE . WABARUERANIE T H AR 2 E e KRG MR R [k
¥

[0544] il ji E?:Eﬂ

[0545] 5 XA BIIAHERGE A I B 28 7 S HE RS SRR oA B 40 o 18] 58 1) e 510 4 18 o
W54 E T

[0546] SR IR AT
[0547] [ & A7 A% D1 B RE AL A% LS AR B BB < [ 52 mARCER A | 18 52 T i AR R AR A
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FARFAE T BN SRR L R IR M o AR BB, Hof— A8 30 B S/ MR R e .
[0548]  [&] 5 AR

[0540] [if] & A7 A% £ A8 1R ST 45 1) 4 [ 5 DT b TROA B BRI — 80 40, 0 R STHTRER [
" AR A AR TS A2 TR B DR R AR R AR R RN a8 Mo [ RS A A AR R Y
application/xml+PLACEHOLDER,

[0550] [ & A A AN A ) B 4Ll I E <Document> TG 3 P ALHE <FixedPanel> JCZ LR
W FRE. £ F SRR, <FixedPanel> JUEIRE T H 24P 24N TR RIE .

[0551] <! —SPINE—>

[0552] <Document $XMLNSFIXED$>

[0553] {FixedPanel>

[0554] <{PageContent Source =" pl.xml” />
[0555] <{PageContent Source =" p2.xml” />
[0556] <{/FixedPanel>

[0557] </Document>

[0558]  <Document) JGZ

[0559]  <Document> JTZ ¥H JE M, I HAW A —F It <FixedPanel>,

[0560] <FixedPanel)> JUZ&

[0561]  <FixedPanel> JUZ & SCRURY AL, "848 F O 0 D P 91 98 A2 — i il
A2 M. TS TR E T H B ORISR S, (B2 <FixedPanel> Jus Al (g
SE e R8T o A5 BT F T M s A1 B I, S, 49 2k T i R /MR R R 2 TR) ik
o WIR <FixedPanel> Jua i€ T i EAITE AL, MBI 7] 55 <FixedPane> A H HUTHI Y 58
JEE I i FE T 55, AFL R I 48 ROST AN 5 A Il D) ey P2 R 586 2 o

[0562] DA RASAK R HEIR () S S 45 T FixedPanel J@ 1.

[0563]
<FixedPanel> &1 BN
PageHeight 57 <FixedPanel> Py UL TH Y 378 &
. nfEk.
PageWidth HEAE <FixedPanel> Py UL 1] ) 41784 55
. nfEk.

[0564] <PageContent) JG %2 <FixedPanel> JLEME— LIFH T 0% . <PageContent> JG
e 5 SO ) 5 AH G FC A P bR 1 2T

[0565] <PageContent> JLZ&

[0566] i} — <PageContent> JTE TR M2 S~ UL I A 25 IR DA 2 SO o T IR 2
&, A XS AE <FixedPanel> Hff) <PageContent> T JL & AT T4

[0567]  <PageContent> JUR WA MVFINFIcE, I HA BN FFEWE M —Source, EFi K
J2 DL P 25 IR o O T A o

[0568] U <FixedPanel> JG % —¥¥, <PageContent> JG 2 1] 4T 1L #h £ F5 PageHeight F
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PageWidth J& P, Ak S T 5 AN BT K/ 77 B 1 0T 1) K /N6 [ 52 0T 1 34 P Fi 2 s
<PageContent> I [{J A {LIE RK/MUE IR . <PageContent> K/IN&E M A 17 1 W SCAY 5%
By S N R ) T SRS PR T b Ak R T AT SR 7 45, AN IR 28RN TR A B A A il [
LB

[0569] T SCHRAERIFME M LE T <PageContent) J@ M IFR4L T @ MEMIHEIA o

[0570]

<{PageContent> J& ik

Source S N AR URT B, BRITER N IAH
SR . A RFR RN R
T,

PageHeight EIERR s

PageWidth ATk

[0571] BTN URT AR b2 | N AN TR A B

[0572]  [f & T [ B

[0573]  <FixedPanel> Ff¥J%;— <PageContent> JLE %4 S (URD) 5| T [l 2 5L 1
B[ 7 G AR AL 2 4 A A DT Y SR B B T AR 0 o [ S I AR A A A
A application/xml+PLACEHOLDER-FixedPage.

[0574] R i A AR IA [ 5 DR

[0575] LA M/2U N ARIbR IS T &k L Sepil i 4810 (<PageContentSource =" pl.
xml " />) H g | BT 7R o

[0576] //  /content/pl.xml

[0577] <FixedPage PageHeight =" 1056” PageWidth =" 816" >
[0578] <{Glyphs

[0579] OriginX =" 96"

[0580] OriginY =" 96"

[0581] UnicodeString =" This is Page 1! ”
[0582] FontUri =" .. /Fonts/Times. TTF”

[0583] FontRenderingEmSize =" 16"

[0584] />

[0585] </FixedPage>

[0586] LI F#EA&E 45T FixedPage )@ EIF42ME T B MEROHEA .
[0587]

FixedPage f)JE M |k

PageHeight T
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FixedPage f)JE M |k

PageWidth T

[0588] TR A E

[0589]  7E—ANSEjti s, £ 7 ZE [ 52 DI N ) Glyphs 76 2% AR 107 0 200 5 0 1 (1)
SCAS P A I B ER S U A 1] o sk U ] H 2k B 8855 48 P IR [ e 0 1 1003 SCAR 1)
A H AR/ WAE, CL A SRV Al 5 i) P AR U7 SCAS I ] o 8 DR AR T A0 S U
(1) 2T YK~ F 8 e e A 3 1 7 O T o i PR S P R 7 B T A

[0590] & ERAT

[0591]1  FHEERI#E L

[0592] A e T S 1y St 491, 281028, m f0) [0 2 0 {8 P 1) PRG0S A2 T LA i o 25 ) A
=, 40 PNG B, JPEG, RVE AT H e s .

[0593]  A{RFRA:

[0594] K BT (1) S A1), 138 A0 S A PREG B I A s 2o A8 BT /s FEA IR 11 5 it 191
SR RS A FE TrueType ¥ 2CFT OpenType #4520

[0595] LA I HE AN 51 T AR K], OpenType “FAHE A2 TrueType FHE KT 1,
IS T XF PostSeript SAAREARE NG 2 IHE A AT R IS EF o OpenType ARSI & R A5 4%
[XIEHRE , BAHE TrueType 3B K E8E PostScript #5714

[0596] i MR BTk 1) S T 9], BNk N ANSCRE LR PR 5K :Adobe 2880 1 A7 B4 B
A RaE M (RGeS R AW T E ) VRE TR EUDC & (H 4k
F 4 42 EUDC)

[0597] A2 B A

[0598]  [if] 5 A &4 B B RS FH R SCIF ARG ¥ Glyphs JTERINITA SCAR. HT7EARS
8] ok R [ 7 15 PR AT BE X AR AT 2 B DN & [ 2 A A 8 w5 2 ALk,
BIAEL P AR DL TR Sk B RV o0 e B I AR AL SR AR 2 AR 1)
FIA T8, SR 73 T B 1 AR b 2R A 31T OpenType SR SCAH

[0599]  FT EPZEHH A

[0600]  #T EPEEEAAFERAL 1 W AEHT ENAL IS A () 1 B o IXLe4T BN S5 W] LU 25 Fh 77 Bt
I, CLSEERSE BT bR R g o 0040, T B0 2248 RT 4 Bon” 284N, I H AL 3B A 5% i B
o FTEN YR ] LAAE S50 T B gt — B B Cdan, BEOmEIAS A 0L ), 3 B 84T Ep
SRR SR T B e AT B0 BB I A FH K 78 d i

[0601]  Hfk P o Eidf

[0602] U1 b priks, IR PR ST EAR S AF A S B A F AR AL T s B R T,
A5 B 27 Re i T SEM R DX S0 o X6 8 Ml T Tl sR o0 TR DL R A4 il
B A PR B A S o

[0603] [ WA bRiCILRAE

[0604]  ATIREIA T 5 [F] 22 UL ARICAE IR B FE L FL A E S, FEEFE LU /Y “EE A A
AL E B iE RV [ 2 DT T PR TE AR Y 7 BRI R TR T 7 DA <] ] 22 AR
A7,
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[0605]  [fi] & A A S AL E R i br it

[o606]  FI 1k A, P 1 A 5 A 2% 47 1) [ SE T AR [ g BT I AR I A2 R H Windows®
Longhorn [f] Avalon XAML Friciy 4. R, RVE [ E A N Bbric A AL XML FRid A%
X CHFEARSCRY g il ) SRS, (HEE LS Longhorn RGEAH 1 77 2k, H £ I0
T JRURZ TUSCRY Y WYSTWYG I

[0607]  1E 4 XAML AR ic R 26T 5, 25 B LU o XAML AR & R 1F B X S 12 IR AR
G P2 AR e 2 A 5L T XML AR Id s 5 BN X R SRR AL T DL XML H5 (1) e
Jo X VP WA AR NET HEZR I A FE 51847 (CLR) S8 P i ml g 78 25 LA XML
KUiil . XAML AL HE T XML FREZEF] CLR X% BRI, L& DIAR iR s AH ARSI BE
770 AT LLBH R BRAR, 25 SEIRAS 75 4 i Hu A% ] XAML (925 T CLR S8 AH R, 25T CLR
1 SEBRARE B T AT AE A SCRYS A R 1) S5 Je 491 A 455 P R FH XAML [ — o7 v

[o608] BT H.fAHh, FrELEEGE 11 MLLT WA, Bn T CLR S (ZEM5r &) 2 XML (4
73 &) 7R S o 24 o TR R OA SO ) CLR M 7E xmins A B4k, KB
ISR 1) XML A28 J& PEFN i i 2 e o A X — 23 ]2 450, B P ml $ia o2 XML Frid 3¢
P HIT— CLR SR K70 =W s xaml SCAF & BA xaml 7 E4 L application/xaml+xml
FTBEARSRAY ) xm] 0o xaml ST RA —MRARAE, BE A H xmins BYHETRE T 455
[ 4578 A A] DAZERR B g R B R g e

[0609]  4k&, xam] SCAFA IARAE— AT 2] CLR A% P8R LLEnR  BEAaEME 2 X
BUBHR o TUER S RRAEBATINGI /R B CLR XSS, B T X B 153 Z 45k . 25 8 bnas
TR EBEARZEPRENE . & PR TR ARSI N2 502 SCR IR . BHiiAn gt 700
IR FE A TRk BRI X S T RE T o 08 MARZEW TR 5 —FRZE P i de 2 4 xmlns
JE .

[0610] —HUbrid (BH BHPEH ) SR 7308, 7r L GBS BB ) ARl
AT L TR B . A I8 B BITEE 0 AT 2 R BRAE P 2 Y. 4 45 2 MR 28 CLR V-2 1 44
FARRRH AR . FEVFZ G 00T , W Mras i AT A4k, FF3H i xmlns J@ P48 € 1) URL
R 24 R AL O 44 -2 A SCSCAH L TV g 1) 44 7 L 22 5Bk A2 1 CLR 44 7
[F AR o TEE S T as 1B BRI, A AT AT AR 2/ xmins DA% xmlns [ xmlns
8 ST 2 bR 285 | WL CLR 28 o 1BVE A A 4% e SOOCPF P s e B0 9 0 28 72 () (1)
WF AT R . 9B VCECH , 1L Hr a1z R I 5o

[o611]  Hyuk, b3k, I HAE ESCHRL 51 H B2 58 4 6 A5 A s b B AL IR e Ve F AR
IEFRE LT T XML SO R R R A AR X4 0 BB AL s A bR il bR 28 (1 RE v LU T
Fr 2 BA P A o5 B R TR s W) [ e s ) SO« B O P S SO N, FH R U T

[0612] 7 7= FF4th 3 1R S it 9] v » [ 5 A A8 0 Bibmid 2 e /D I, LT 584 At B IR 1)
Avalon XAML HJ7 A8 I 4. & H B2 M IR IR 7R 1 7] LU Avalon 7R AR A
Fo [HEA N BHRILZ Avalon XAML JoZ B MR 74 - 0 B Ing25E BB B,
5 Avalon XAML #H ELAEA# A 2 LI BR H1 o

[0613] & M 5Ea /P e AR bR id S b T 5 BIA L P 523, ndTERAL RIP BUAC
FAEEE A N R 7 0 S IR A DS BRI A — FF kb 1 AH QIR IR 1B 20 B 4t 1) B2 %
FERAEE AR T o A RIPRIC R i/ ME T 20 BB B iR BB A 5 3 I B 52 3 22 [H)
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ISR, T2 X LA R G N e 5

[0614] [ f /)N I [ 52 A A8 0 Bobm 1 2 A, BIIE A 0 B 0 i SCE S48 e Fn i, BASCHE
LA WO BERE AR/ R AN G5 A6 R0 3 T SCAS I £ R0 SR AT 7 0] 1 S5 R AR 1) 22 7 4 21 1k
(O

[0615] s )i, ¥ F FOR AL ATRT 4 78 PEAL], F A T4 2 1K B ARV AE RN R 7 5B 44
BRI B 3 (1) 7T 22 B b A b 78 5/ IR ] o A 20 0 28obm i = T BB 1Y o

[o616] [ 5 U A i A2 2R

[0617] 7 Ffrom FF 4l (1) St 49 o, [ e o i A 2 25 T XML Je 25 XML Jo @ P A XML 44
AN LAZE T XML BIFRIC T8 B 2R R IA N o AR e T =AY XML 44 575 ) DL & 78 ] 5 1L
fFRIEH e — MXFERI G F A0 S5 T AUl A5 A et 5 @ SO A = il o 3= A g P
FH T [ 52 v i br i A i oo 2= 808 P R U 4 8 TR) A2 “http://schemas. microsoft. com/
MMCF-PLACEHOLDER-FixedPage”. )&, [E & W HIFR T I T “BEU7 RIS, B 755 T 3CH:
IR IER =A% A5

[o618] L[] i U [HI A i 2 A XML JoZ A XML JT @ Mk 3R IA I, SR H e & T “
7R SEYE” B S A R ALY, [ 2 T TR AR AR IE N XML JTER . A ERE 2 v oo
RAEG N, RIE N XL %75%%0 B2 R A WA A XML JoJ8 sk A A XML ook
KiK.

[0619] [ 3 VL [T A dekt AR T 0 - LRI B 0 5 | FH I XU - o R 7~ R 2 AN B8 05 |
W%AﬁﬁiAEﬁﬁﬁ%AIEﬁﬁﬁﬂE%m%AETA%

[0620] ] ) JE

[0621] E%Tﬁ%ﬁ%*%%*%?*W@W%ﬂabMT%?hEIEﬁﬁﬁﬁE
PE IR

[0622] 1 5 J& PR A FH Bt U5 | FH ke ¥ e 1, W) J 1k 44 A XML Je i@ 1 44, 9 L& (R 1)
Repk izt 7RIS I IO EE. A TRETEIRS | H I AVELE R 8 “ BIs f et di o L 7 —
R E P

[0623] A A ¥ e Ay W YR 5 | FH AR T mT DA FH b R AR 48t e B 1) M X Bk 2 XML
TR UL XML SRR IS, % “BABMIEANE” 765 Uk .

[0624] )i, FLALAEGRUR 5| FH e PR ] A 3R 8 0 T B S0 A R o RV T IR I S A ]
DI 56 8 1t Rgvke s, SR e AT w4 7] 5019 XML Jo ) MErgvdeoke Rk

[0625] X THE—25 2ot s, (B @ LI ik BEAZ Tk, LieHl THe e &1 A
a4

[0626]  fRjEJETEA)Y

[0627] X TR e e 1k oA fiaj 5 o 16 & AR, mT A XML o & MERJvoike e l@ e . lan, 45
SEMRA “SolidColorBrush (A fafl] ) ” [IE & Wifibrid iz, B HA %A “Color (B ) ”
())& P, TS LA Fidiokdi e Ja PR

[0628] <! —Simple Attribute Syntax—>

[0629] <SolidColorBrush Color =" #FF0000" />

[0630] K &Ry

[0631] IR PEAEANBEMRIE N S A, Bl XML Jess TR e MR fE. X — R MM
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ANREAE i o B ME )y Rk . (HR AR H B & B M aik Rk,

[0632] FERGJRVEAIEH, MR T XML FIo s, (RN TR A B EA A4 T H XML
TCEL, UL ARG . 45 e T EARIC T E Path> (42, CBA B “Fill”, &al i
B3 <SolidColorBrush>, Al F LA FARic K1 E Path> JLERH “Fill” @k -

[0633] <! —Compound-Property Syntax—>

[0634]  <Path>

[0635] {Path.Fill>

[0636] <{SolidColorBrush Color =" #FF0000"” />
[0637] {/Path.Fill>

[0638]

[0639]  </Path>

[0640] 5345 Je8 11 o) vk RIS 1 i R 8 ok v e AR AR JE A IS 0 T nT s . BRI, i
IR

[0641] <! —Simple Attribute Syntax—>

[0642] <SolidColorBrush Color =" #FF0000" />

[0643] W EARHE LR & J& 1t ok RIS

[0644] <! —Compound-Property Syntax—>
[0645] <SolidColorBrush>
[0646] {SolidColorBrush. Color>#FF0000</SolidColorBrush. Color>

[0647] </SolidColorBrush>

[o648]  4Adi HI 525 J& 1t rgvkk i e S PEAEIN, 2o B 1t 1 XML ¥ oo s B AU AR R R
CONZT B XML FIOCERZAT. MHEABYE XML FOeE T A R EE R, el
AL TC R IAFAT “ A" Z AT o

[o649] {5 4n, 4 fff H <Canvas>( i A ) jt & (F 3C i &) I Clip( & By ) M
RenderTransform ({EZALH ) J&MENS, XA @ 1 &R L6 20 H IRAE <Canvas> [FJ{EAT <Path>
Fl <Glyphs> W& AT :

[0650] <Canvas>

[0651] <! —First, the property-related child elements—>
[0652] {Canvas. RenderTransform>

[0653] MatrixTransform Matrix =" 1,0,0,1,0,0" >
[0654] {/Canvas. RenderTransform>

[0655] {Canvas. Clip>

[0656] {PathGeometry>

[0657]

[0658] <{/PathGeometry>

[0659] {/Canvas. Clip>

[0660] <! —Then, the” Contents” ——>

[0661] {Path...>

[0662]
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[0663] </Path>
[0664] <{Glyphs...>
[0665]

[0666] </Glyphs>

[0667] </Canvas>

[o668]  BEY AT 5| H]

[0669]  WRyR ML A H T AN ] LS 1 JE AR, SL— AN R O s FLAS B R [ e v
PRIt e AT — B AR P AN FE SR i o SR 2 M rp i e — SRR — 2 5. BEUR
LT T27% 2k A B MR XML 7o 8 M 55 0

[0670] LT 7R T4k () 5L Jitif5) 7, <Canvas> #l <FixedPage> Juz ] 5 W M. BRI
F U2 DIARIL R IE N 44 4 “Resource (BHR ) I JE W ) <Canvas> Ml <FixedPage> JLZ ]
JETE . SR, A BB IR E Bk AE <FixedPage. Resources)> 8 <Canvas. Resources>XML
JLE W . AJ¥E L, <Canvas. Resources> fll <FixedPage. Resource> fIbrid BT EAEH WA
IFRICTCER -

[0671]  fKMEASL ], <Canvas. Resources> o¥ <FixedPage. Resources> W4 {F <Canvas>
8\ <FixedPage> W AF B & )8 1% 7% 8 A 2 /. 28U, & AT 20 fF <Canvas> Bk
<FixedPage> T “HN A" Z AT -

[0672] i ] s A ARk A A8 e i

[0673]  {F{ <FixedPage> Y <Canvas)> n] #: 17 % Jf 7 #, B <Canvas. Resource>XML JGC %
KKIE, BPAREFMN Ao R WS T ME— 8, WA 5% 0 ZAH KRR
XML Jo @ MR AR K% Name ” 7o J&8 M -5 60 W 1 J@8 M) I8 £ 50 J@ P14 T [X 43, Name JT )&
MEH A 5 e R LT R A E A A E R 7 /). % XML 44 5275 (B¢ URT J2 “http://
schemas. microsoft. com/PLACEHOLDER-for—resources”. fFLL R, & T PIFh JLAT
G R, R

[0674] <Canvas xmlns:def = " http://schemas.microsoft.com/
PLACEHOLDER-for-resources” >

[0675] {Canvas. Resources>

[0676] <{PathGeometry def:Name =" Rectangle” >
[0677] {PathFigure>

[0678]

[0679] {/PathFigure>

[0680] <{/PathGeometry>

[0681] {PathGeometry def:Name =" Circle” >
[0682] {PathFigure>

[0683]

[0684] {/PathFigure>

[0685] <{/PathGeometry>

[0686] {/Canvas. Resources>

[0687] </Canvas>
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lo688] | A&k

[0689] At MEAE A b 30 IR — A AE {0 WARLE SR A 1) XML JE A . 131
U1, “ {Rectangle} ” ¥4 K n BAF A Z LA S50 o £ELL N ARICHEBI P, 2 B0 b (1) LART 5 fa) ot
% 58 LI TR X 3804 B SolidColorBrush SRIE S .

[0690] <Canvas>

[0691] {Canvas. Resources>

[0692] {PathGeometry def:Name =" Rectangle” >
[0693]

[0694] <{/PathGeometry>

[0695] {/Canvas. Resources>

[0696] {Path>

[0697] {Path. Data>

[0698] {PathGeometry PathGeometry =" {Rectangle}” />
[0699] {/Path. Data>

[0700] <{Path.Fill>

[0701] {SolidColorBrush Color =" #FF0000" />
[0702] {/Path.Fill>

[0703] {/Path>

[0704] </Canvas>

[0705]  AIEACSL s, B U 5 | FH DA 20 AS H AT 08 U 7 M iR B s S o

[0706] M A e 30 5 | P ERT RS A A )

[0707]  RVEFAE[R]— B8 U8 5 L Py ] RE VAT B 4 E IR, AR R — 4 1] LA AE A
[ 5 DT [ B PR AS AN TR R B0 - L P o A, YR <Canvas> YR 5 HURT 85 55 4 FH Lt
4pEB <Canvas)> B <FixedPage> %Y 7 N & X K4 T

[0708] st FH B2 5 | FH R VB T 28 1 & Pk I, 48 38 25 A BRI 7 R R HH 26 2 2 I
o AR BEA)E MR JTE Z <Canvas>, WHE K i% <Canvas> % M (LA K )
DLk I E 4 T B R . W1 R o0 3 AN & <Canvas), W8 &R DL #3810 49 5 <Canvas)> B
<FixedPage> FF4fio W1 F7E i A48 Z I B2 U5 7 M Py A o SR 1) 44 5%, W) — e
I AL 7 <Canvas> B( <FixedPage>. WIH W RIRLL B <FixedPage> L E, I HAE 5%
<FixedPage> FHIRIR I BT - I A R H B B0 28 44 - () B U, ) H IR A %

[0700] DA RoRflRn T X e,

[0710] <FixedPage xmlns:def = " http://schemas.microsoft.com/
PLACEHOLDER-for-resources”

[0711] PageHeight =" 1056" PageWidth =" 816" >

[0712] {FixedPage. Resources>

[0713] <Fill def:Name =" FavoriteColorFill” >

[0714] {SolidColorBrush Color =" #808080" />

[0715] <Fill>

[0716] </FixedPage. Resources>
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[0717]
[0718]
[0719]
[0720]
[0721]
[0722]
[0723]
[0724]
[0725]
[0726]
[0727]
[0728]
[0729]
[0730]
[0731]
[0732]
[0733]
[0734]
[0735]
[0736]
[0737]
[0738]
[0739]
[0740]
[0741]
[0742]
[0743]
[0744]
[0745]
[0746]

{Canvas>
{Canvas. Resources>
<Fill def:Name =" FavoriteColorFill” >
{SolidColorBrush Color =" #000000" />
</Fill>
{/Canvas. Resources>
<! —The following Path will be filed with color#000000—>
<Path Fill =" {FavoriteColorFill}"” >
{Path. Data>

<{/Path. Data>

</Path>

{Canvas>
{! —The following Path will be filed with color#000000—>
<{Path Fill =" {FavoriteColorFill}"” >

{Path. Data>

<{/Path. Data>

</Path>
</Canvas>
</Canvas>
{—The following path will be filled with color#808080——>
<Path Fill =" {FavoriteColorFill}” >

<{Path. Data>

</Path. Data>
</Path>
<{/FixedPage>
[ 7 v £ T A Y
[ 2 e R (B ERNEAT R ) qaH FERHLE TR TR WA

A7) FEONT [ 2 DT smiA ) 45 e e g i (SomiA ) BT ETEE R T PR
XTI 7 T 44 72 1) i SCRR 2 e o422

[0747]
[0748]

1] AT K T A TR

FE [ FE bRIT o BT I 0 s HARD AR R AT I (0, 0) RIEAL. AT IR

A ATl ek e A e E A [ s o s AT R — e 2 N A RenderTransform )& Mk 5] .

[0749]
[0750]
[0751]
[0752]

PR 77 1 T 38 RenderTransform X JC & WAL
{Canvas>
{Canvas. Resources>
<{PathGeometry def:Name =" StarFish” >
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[0753] {1l —Various PathFigures in here—>

[0754]

[0755] <{/PathGeometry>

[0756] {PathGeometry def:Name =" LogoShape” >

[0757] <! —Various PathFigures in here—>

[0758]

[0759] </PathGeometry>

[0760] {/Canvas. Resources>

[0761] {1 —Draw a green StarFish and a red LogoShape shifted by 100 to
the right and 50 down

[0762] -—>

[0763] {Canvas>

[0764] {Canvas. RenderTransform>

[0765] MatrixTransform Matrix =" 1,0,0,1,100,50" />
[0766] {/Canvas. RenderTransform>

[0767] {Path Fill =" #00FF00"” Data =" {StarFish}” />
[0768] <{Path Fill =" #FF0000” Data =" {LogoShape}” />
[0769] {/Canvas>

[0770] {1 —Draw a green StarFish and a red LogoShape shifted by 200 to
the right and 250 down

[0771] -

[0772] {Canvas>

[0773] {Canvas. RenderTransform>

[0774] MatrixTransform Matrix =" 1,0,0,1,200,250" />
[0775] {/Canvas. RenderTransform>

[0776] <{Path Fill =" #00FF00” Data =" ({StarFish}"” />
[0777] {Path Fill =" #FF0000” Data =" {LogoShape}” />
[0778] {/Canvas>

[0779] </Canvas>

[0780]  ARbR RGEAUERAS

[0781] K BE PR FFEFE A 1 S i), Sew) VB AR bR R e, AT AT i AR AR RGP I — > L 55
THT I 1/96, #3218 V% s (8, PR RS R A (0,0) 2 e TR s LA

[0782]  RenderTransform Jt )& PE W] LLIEAE—FJu R LRE, LLIn S a1 AR AR RGN F A7 56
.

[0783]  HEIA
[0784]  WTihl RT3 BUIHI J0 38 L f“PageWidth ( BUFEE ) "Rl“Pageteight ( BUHJE ) ”
SHORARE -

[0785]  ZH sl
[o786] [l il A 7 HA o WIEMEEIRE PR, HCHE BT R IR 1) S HE] , 20 B 204k
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HEIX LRI, I H ABL 7 &2 A

[0787] @[] & UUfi ( BRARAT BRI AT ) HA AR TR AR, iz i e H IR
TEARIEH IR P F e 5% . AR o WEWYILEA A “0.0” (4H0EH ) . SEhr b,
HEAR I G G 3R AT DA A A A — B s B G i X, & AR 8 R A g i R I 1§ 0 5™
ERIPFT A bRId.

[0788] @M 1) P 7 A FH b [ 2 i ( BYCEIAT ) PRIV L AR 90 J 1tk 8 e 10 S AR 4k AR
o

[0789] @ FTHNFIuE At E IR M b Bl e vo (smAn ) e B EREET (Wi
A8 FHVE P An 4 @ ke AR ¥ ) o [ 5E DI 3 AR B R (0,0, PageWitch, PageHeight) $RiE
M. WRFIuRBEAANEN (Opacity) BIEEAZ AR (OpacityMask) J&MH:, W'
E2MBIR T E2 ATV BNZF TR

[0790] @i /a, [ E v ( BumEAn ) WA EMBIHLAE0E B 7R @ i m o
T, B E TR AW BB R R .

[0791]  SHLAK R LERRI & A

[0792]  @{EKME L AFRidHIME— oz 2 “FIE (Glyphs) ” Ml “#f4% (Path) 7.

[0793] @A EREIHBR @R <77 it w2 “mAn” F, FFNVH
HARA 0T B MRS .

[0794] [l R on = AE

[0795] K HE BT/ IF R 1) St 9], [ 7 A 4% S B G A b i oh A T3 T B L N 1)
— /N XML TG ER o 8] 5 T A A A i B e d A <Document> . <FixedPanel> Fll <PageContent>
JCE K ORI T — R B — A HEAE S RO B[ E i R s A
<Path> Ml <Glyphs> JtF (EAIILFEZERITA KL ) 1) <FixedPage> TG, LA A& EAT
1) <Canvas> JTZ& "I UL I P 2%

[0796]  [&[sE A bR I TR 3 Z S MAELL N 8 “TRg T 27 “ T B8 12 B B37L
FIE5H 7 T T IR R BE AR T BUANZE BHHEAS R Rl FH T 8 a2 0 1y Bl i A R 8 905 L 7
“HT o MR AT AL, “FRBIEER” T AR [P F sl

[0797]  THZicH:

[0798] @ <Document> [ X[ & AR AT R A —4 ]

[0799]  OJtla: -

[08o0] W[ ]

[0801] OFILE :

[0802] M <FixedPanel>[ HA—]

[0803] @ <FixedPanel>

[0s804]  OJt)E :

[0805] M PageHeight[ RJ{Fik ]

[0806] M PageWidth[ AJ{Ti% ]

[0807] OFITEH :

[0808] M <PageContent>[ XL ILE ] 1-N > ]

[0809] @ <PageContent>
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[os10]  OJc/E: -

[0811] M Source[ 5% ]

[0812] M PageHeight[ H[{F-i% ]

[0813] M PageWidth[ W[{F-ik ]

[0814] O ICH :

[0os15] W [ ]

[0816] @ <Fixedpage>

[0817]  OJELL # XML jojE M HEREW B
[0818] M PageHeight [ % (JLALEIEA T U5 )]
[0819] M PageWidth[ 752 (JLALE/E N TI05)]
[0820]  OFKiLA XML FIoE IR IS F AL .
[0821] M <FixedPage. Resouces>

[0822] Ot XML Fre&EREMEM

[0823] M <FixedPage.PageHeight>[ f5 %5 (HALsAE N CENE )]
[0824] M <FixedPage.PageWidth>[ 752 ( Mhabsk/EmicENM )]
[0825] Qifiit XML FIo & EEHINE -

[0826] M <Canvas>

[0827] M <Path>

[0828] M <Glyphs>

[0829] @ <Canvas>

[0830] Ok fij & XML JTJ& M B IE B
[0831] M Opacity

[0832] Ol i ¥t i s | R B I T -

[0833] M Clip

[0834] M RenderTransform

[0835] M OpacityMask

[0836] OFKILA XML FIoEH IR IR T AL .
[0837] M <Canvas. Resources>

[0838] Oiid XML FIomEERIEM -

[0839] B <Canvas. Opacity>

[0840] B <Canvas. Clip>

[0841] M <Canvas. RenderTransform>

[0842] M <Canvas. OpacityMask>

[0843] Qifit XML FIo & EEHINE -

[0844] M <Canvas>

[0845] M <Path>

[0846] M <Glyphs>

[0847] @ <Path>

[0848] Ok fij & XML JTJ& M HRRIE B
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[0849] B Opacity

[0850] Ol id i v 5 | IR A K Js k-
[0851] M Clip

[0852] M RenderTransfrom

[0853] M OpacityMask

[0854] M Fill

[0855] Ot XML T LKA K&
[0856] B <Path. Opacity>

[0857] B <Path. Clip>

[0858] M <Path. RenderTransform>
[0859] M <Path. OpacityMask>

[0860] M <Path.Fill>

[0861] M <Path.Data>

[0862] @ <Glyphs>

[0863] Ot fij it XML JoJE M HERIE N B
[0864] B Opacity

[0865] M Bidilevel

[0866] M FontFacelndex

[0867] M FontHintingEmSize

[0868] M FontRenderingEmSize
[0869] M FontUri

[0870] M Indices

[0871] M OriginX

[0872] B OriginY

[0873] B Sideways

[0874] M StyleSimulations

[0875] B UnicodeString

[0876]  Oufiid B 35| FHRE I @ I
[0877] B Clip

[0878] M RenderTransform

[0879] M OpacityMask

[0880] Wmrill

[0s81] Ol XML Fro&ZREMEM
[0882] M <Glyphs. Clip>

[0883] M <Glyphs. RenderTransfrom>
[0884] M <Glyphs. OpacityMask>
[0885] M <Glyphs.Fill>

[0886] M <Glyphs. Opacity>

[0887] M <Glyphs .BidiLevel>
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[0888] M <Glyphs. FontFacelndex>

[0889] M <Glyphs. FontHintingEmSize>
[0890] M <Glyphs. FontRenderingEmSize>
[0891] M <Glyphs. FontUri>

[0892] M <Glyphs. Indices>

[0893] M <Glyphs. OriginX>

[0894] M <Glyphs.OriginY>

[0895] B <Glyphs. Sideways>

[0896] M <Glyphs. StyleSimulations>
[0897] M <Glyphs. UnicodeString>

[0898]  F T-E& 7% EBYIK LA 4544

[0899] @ <Path.Data>

[0900]  OJc/EE: -

[o901] W[ JC]

[0902]  OFEANHEA XML FIoER K EHAL
[0903]  [Path. Data S3L HAXLEFITUEM— ]
[0904] M <GeometryCollection>

[0905] B <PathGeometry>

[0906] @ <GeometryCollection>

[0907]  OJt/a -

[0908] M CombineMode

[0909] OFJt%

[0910]  [I-NFJ0% |

[0911] M <GeometryCollection>

[0912] B <PathGeometry>

[0913] @ <PathGeometry>

[0914] OJtEMk -

[0915] M FillRule

[0916] OFILE :

[0917]  [I-NATICE ]

[(0918] M <PathFigure>

[0919] @ <PathFigure>

[0920]  OJt)af -

[0921] W[ JC]

[0922] OFILE -

[0923] [ H4cH L StartSegment, 5 Jii L CloseSegment, 1 E]H 1-N 4> Ploy*]
[0924] B <StartSegment>

[0925] M <PolyLineSegment>

[0926] M <PolyBezierSegment>
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[0927]
[0928]
[0929]
[0930]
[0931]
[0932]
[0933]
[0934]
[0935]
[0936]
[0937]
[0938]
[0939]
[0940]
[0941]
[0942]
[0943]
[0944]
[0945]
[0946]
[0947]
[0948]
[0949]
[0950]
[0951]
[0952]
[0953]
[0954]
[0955]
[0956]
[0957]
[0958]
[0959]
[0960]
[0961]
[0962]
[0963]
[0964]
[0965]

B <CloseSegment>

@® <{StartSegment>

Ol L faf 55 XML Jo e 1 Bk IS g ME -
M Point

Ot XML F e s R g Tk

M <{StartSement. Point>

® <PolyLineSegment>

O L faf 5 XML JT e 1 BRI B M -
M Points

O XML FIuE R K JE I

B <PolyLineSegment. Points>

® <{PolyBezierSegment>

O L faf 5 XML Ju e 1 B IA B M -
M Points

O XML TIrus KB K JE I

B <PolyBezierSegment. Points>

T REAE 7 TE s AN I FE AL A Il 1
@® <Path.Fill>

Ot -

N

OFIE N5 XML F o= I JE A -
[Path. Fill HA XL FICREK A ]

M <SolidColorBrush>

B <ImageBrush>

B <DrawingBrush>

M <LinearGradientBrush>

M <RadialGradientBrush>

® <Glyphs.Fill>

Ot -

WKL)

OFKIENEA XML FIo R E A
[Glyphs. Fill U IR oA —A ]
M <SolidColorBrush>

B <ImageBrush>

B <DrawingBrush>

M <LinearGradientBrush>

M <RadialGradientBrush>

@® <SolidColorBrush>

Ol L faf 55 XML Jo g 1 Bk IS JE M -
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[0966]
[0967]
[0968]
[0969]
[0970]
[0971]
[0972]
[0973]
[0974]
[0975]
[0976]
[0977]
[0978]
[0979]
[0980]
[0981]
[0982]
[0983]
[0984]
[0985]
[0986]
[0987]
[0988]
[0989]
[0990]
[0991]
[0992]
[0993]
[0994]
[0995]
[0996]
[0997]
[0998]
[0999]
[1000]
[1001]
[1002]
[1003]
[1004]

B Opacity
B Color
O XML FIn R FRIEM B

M <SolidColorBrush. Opacity>
M <SolidColorBrush. Color>

@® <ImageBrush>

Ol iy 5 XML JoJa I ERRE K@ 1k -

M Opacity

B HorizontalAlignment

B VerticalAlignment

M Viewbox
M ViewPort
M Stretch
M TileMode

B ContentUnits

B ViewportUnits

B ImageSource

Ot B 7 i 5| IR IE 1 J8 o

B Transform

Oiiid XML I ERIEM B -

B <ImageBrush.
M <ImageBrush.
M <ImageBrush.
B <ImageBrush.
B <ImageBrush.
B <ImageBrush.
B <ImageBrush.
B <ImageBrush.
B <ImageBrush.
B <ImageBrush.
B <ImageBrush.

Opacity>

Transform>
HorizontalAlignment>
VerticalAlignment>
ViewBox>

ViewPort>

Stretch>

TileMode>
ContentUnits>
ViewportUnits>

ImageSource>

® <{DrawingBrush>
Ot & 5 XML Jo)g Mt HER AR EME

B Opacity

B HorizontalAlignment

B VerticalAlignment

Bl ViewBox
B ViewPort
Bl Stretch
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[1005]
[1006]
[1007]
[1008]
[1009]
[1010]
[1011]
[1012]
[1013]
[1014]
[1015]
[1016]
[1017]
[1018]
[1019]
[1020]
[1021]
[1022]
[1023]
[1024]
[1025]
[1026]
[1027]
[1028]
[1029]
[1030]
[1031]
[1032]
[1033]
[1034]
[1035]
[1036]
[1037]
[1038]
[1039]
[1040]
[1041]
[1042]
[1043]

M TileMode

B ContentUnits

B VeiwportUnits

O B 7 5 | RIS K R E -

M Transform

B Drawing

Oifiid XML FIuHERIKM BN -

B <DrawingBrush. Opacity>

B <DrawingBrush. Transform>

B <DrawingBrush. HorizontalAlignment>
B <DrawingBrush. Verticalalignment>
B <DrawingBrush. ViewBox>

B <DrawingBrush. ViewPort>

B <DrawingBrush. Stretch>

B <DrawingBrush. TileMode>

B <DrawingBrush. ContentUnits>

B DrawingBrush. ViewportUnits>

B <DrawingBrush. Drawing>

® <DrawingBrush. Drawing>

Ol XML Tt s RIKMNZ -

M <Canvas>

M <Path>

M <Glyphs>

@ <{LinearGradientBrush>

O faf 5 XML JT e 1t B IA g -
M Opacity

B MappingMode

B SpreadMethod

M StartPoint

M EndPoint

O i B 7 g | R H @ 1k -

M Transform

B GradientStops

O XML FIrus R HJE I

B <LinearGradientBrush. Opacity>

B <LinearGradientBrush. Transform>
B <LinearGradientBrush. MappingMode>
B <LinearGradient. Brush. SpreadMethod>
B <LinearGradientBrush. StartPoint>
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53/81 1t

[1044]
[1045]
[1046]
[1047]
[1048]
[1049]
[1050]
[1051]
[1052]
[1053]
[1054]
[1055]
[1056]
[1057]
[1058]
[1059]
[1060]
[1061]
[1062]
[1063]
[1064]
[1065]
[1066]
[1067]
[1068]
[1069]
[1070]
[1071]
[1072]
[1073]
[1074]
[1075]
[1076]
[1077]
[1078]
[1079]
[1080]
[1081]
[1082]

B <LinearGradientBrush. EndPoint>

B <LinearGradientBrush. GradientStops>
@ <RadialGradientBrush>

O id faj 5 XML Ju@ M HERIK MBI
M Opacity

M Center

M Focus

M RadiusX

M RadiusY

Ol i B 7 5 | IR & 1k -

M Transform

B GradientStops

Ol ML F e RIS B -

B <RadialGradientBrush. Opacity>

B <RadialGradientBrush. Transform>

M <RadialGradientBrush. Center>

B <RadialGradientBrush. Focus>

B <RadialGradientBrush. RadiusX>

M <RadialGradientBrush. RadiusY>

B <RadialGradientBrush. GradientStops>
® <{GradientStops>

Olflid XML FIuRRIEHK N A -

B <GradientStop> [ IXLEF L E K 1-N /]
® <{GradientStop>

O faf 5 XML JT e 1t B IA g -
M Color

M Offset

O XML FIua R K JE I

B <GradientStop. Color>

B <GradientStop. Offset>

FH T I 5 0 T s AT PR 8 95

® <FixedPage. Resources>

@ <Canvas. Resources>
XUETTERAE B BRI L — b O TR
T o JBUIVERIANE U] P

® <Canvas. OpacityMask>

Ot -

Wm[i]

OFRIEHBA XML FICH B -
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[1083] [Canvas. OpacityMask R H XL T IL 2K — ]
[1084] M <SolidColorBrush>

[1085] M <ImageBrush>

[1086] M <DrawingBrush>

[1087] M <LinearGradientBrush>

[1088] M <RadialGradientBrush>

[1089] @ <Path. OpacityMask>

[1090] OJt/EM -

[1091] W [JC]

[1092]  OFKEANHFA XML Fo R M EHAL
[1093]  [Path. OpacityMask HA XL FILHE M — ]
[1094] M <SolidColorBrush>

[1095] M <ImageBrush>

[1096] M <DrawingBrush>

[1097] M <LinearGradientBrush>

[1098] M <RadialGradientBrush>

[1099] @ <Glyphs. OpacityMask>

[1100]  OJc/E: -

[1101] W[ JC]

[1102]  ORIEA A XML FICH B A -
[1103]  [Glyphs. OpacityMask R IXEETITCEKT— ]
[1104] M <SolidColorBrush>

[1105] M <ImageBrush>

[1106] M <DrawingBrush>

[1107] M <LinearGradientBrush>

[1108] M <RadialGradientBrush>

[1100]  #BY#AR

[1110] @ <Canvas.Clip>

[1111]  OJclEk -

[1112] W [k]

[1113]  OREANHEA XML Fo R K EHAY
[1114]  [Canvas. Clip A RXLE LR ]
[1115] M <GeometryCollection>

[1116] B <PathGeometry>

[1117] @ <Path.Clip>

[1118]  OJc/E: -

[1119] W[ JE]

[1120]  ORIEA A XML FICH B A -
[1121]  [Path. Clip H A XL FILRH—4 ]

59



CN 1961304 B WO B 55/81 T

[1122] M <GeometryCollection>

[1123] B <PathGeometry>

[1124] @ <Glyphs.Clip>

[1125]  OJt/E -

[1126] W[ G

[1127]  OFREANBEA XML F o R B
[1128]  [Glyphs. Clip A RXLEFILREK—1 ]
[1129] M <GeometryCollection>

[1130] B <PathGeometry>

[1131] 7

[1132] @ <Canvas. RenderTransform>

[1133]  ORIEN A XML T ICH A JE A -
[1134] M MatrixTransform>[ 7% ]

[1135] @ <Path. RenderTransfrom>

[1136]  ORIEN A XML T ICE A JE PEAH -
[11377 M MatrixTransform[ 75 % ]

[1138] @ <Glyphs. RenderTransform>

[1130]  OZRIEN A XML FICE I JE PEAH -
[1140] M MatrixTransform>[ 7% ]

[1141] @ MatrixTransform>

[1142]  OJELLfi 5 XML o8 M BRR AW EE
[1143] M Matrix

[1144] Ol XML FrosREn gk -

[1145] M MatrixTransform. Matrix>

[1146] @ <ImageBrush. Transform>

[1147] OB # XML JojE M HEERENEE
[1148] M MatrixTransform

[1149] Ot XML FIe&REMEM

[1150] M <ImageBrush. Transform. MatrixTransform>
[1151] @ <DrawingBrush. Transform>

[1152]  OJ@ELLf 5 XML o8 M HiRE W EE
[1153] M MatrixTransform

[1154] Ot XML T e R EIENE T

[1155] M <DrawingBrush. Transform. MatrixTransform>
[1156] @ <LinearGradientBrush. Transform>
[1157]  OJ@ELL i XML o8 M BiR AW EE
[1158] M MatrixTransform

[1150] Ot XML T e R LR @1

[1160] B <{LinearGradientBrush. Transform. MatrixTransform>
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[1161] @ <RadialGradientBrush. Transform>

[1162] Ot fijse XML Jo)E M R IER B

[1163] M MatrixTransform

[1164] Ot XML FICR KL BN -

[1165] M <RadialGradientBrush. Transform. MatrixTransform>

i166] [ UL

[1167] [ & AR 7R <FixedPage> Juz HE MY XML FRic i 5O A 2% . 1%
[# % TR G SR A T 55 2B AN B 1 IR SCR ) WYSTWYG fRILEE, g — /N TE AR
P :<Path> M1 <Glyphs> Jug (FLFE5ER T ra izl ), LA S A <Canvas> JGE .
[1168] AHITHREM

[1169]  {EisH Xt [ & vt f i o i — o T I 2 BT, B X 2 A 5 e R A
A JETE :Opacity.Clip.RenderTransform 1 OpacityMask, iXEEANN A2 AT G2 A H
R JE M, EA R NSOT R B 7o “FR 7 L85 R —Jg M, a3 “ZH ) —y
PR ity ZEAE N AL RGN 25 51 o BUH SRR SR 7 X bt A J& 1 G i, A &
XA JE MR S SR IR

[1170]

JE v JUHR P
Opacity [Canvas.Path.Glyphs PLK & X e ZE W05 I

SolidColorBrush. ImageBrush.

DrawingBrush. LinearGradientBrush.

RadialGradientBrush
[1171]
TIUHR JCR Eiip
Clip Canvas. Path. Glyphs Clip PRI T A [y FLAE AR [y F

B3 FRY DX

RenderTransfrom |Canvas. Path. Glyphs RanderTransform AiZICE K T IC
FEN T HHIAARRSE R . X

MatrixTransfrom %5,

OpacityMask Canvas. Path.Glyphs YeE T LLY Opacity JBIEAHRIR
AN AN o ERHEEEE, HE R
VPG R EAFER o {8,

[1172]  Opacity Jg
[1173]  Opacity (ANFEHM) B TEERER (a ELY) EHES A ITE . Opacity
JEMERTEEM 0 (e ) 2 1 (ERaAER) « ZHE XIS ELEbR I EE 2 A id R
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PR EIENZACE Py o BRI, AR, [ oo L. 0] RIEWI, M [1... o ] BAFEWN.
[1174]  Opacity J@PEEE LR SORM T (ABCE AR B 22 3RIEAN B bR, 19 2 # g de 2

A scRGB)

[1175] Oy :JuE ¥ Opacity J& 1 Ek OpacityMask Hf AL EALK] a {H
[1176] A PRI PAFAER) o {8

[1177] Ry PRI P AAAER A (A

[1178] G YRR P AFAER S AE

[1179] B YR P AF AR (A

[1180] A, :HARRE T CEAFER o (A
[1181] R, : AR A FERILAH
[1182] G, : HAnKmE P A PRI ZRAE
[1183] B, : HArK M A 7 LR
[1184] A" X HFRKIIRM o A
[1185] " Xf HARR T LA
[1186] G X HFraK M TS 4R {E

[1187] B X H bR 1 Fr {5 i {E

[1188]  FH T FhrtaE BT RN (4, Ry) o
[1189] DR 1 YR o {55 A% PE(IAHR
[1190] A, = A0,

[1191] g 2 . HARENE o

[1192] A, = Aq

[1193] R, = RgA,

[1194] G, = Gg¥A

[1195] B, = Bg¥A,

[1196] g 3a: QAT HIE o

[1197] A, = A,

[1198] Ry, = R*A,

[1199] Gy, = Gy*A,

[1200] B, = B*A,

[1201] DIE 3b :JBE

[1202] A, = (1-A;) %A, A,

[1203] R, = (1-A;) *Rp,+R;,

[1204] G, = (1-A;) %Gy, +Gyy

[1205] B, = (1-A;)*B,+B,,

[1206]  ZDHR 4« Jg ¥ 4 /03

[1207]  fif A, = 0, WP ATE I ARGV B" B R 0
[1208] 750

[1209] A" = A,

[1210] R*=R,,/A,
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[1211]  G* = G,/A,

[1212]  B* = B,/A,

[1213] Clip ,%'i

[1214]  Clip J@Made e b )L 454 0 % <GeometryCollection) Bk <PathGeomerty> & —
( ) Path. Data DAANTE4NY )

[1215]  Clip J@ME A LAR 77 O] -

[1216] @A AN Clip FICRFIR R LTS 03 W E 2 IRN A2 7 LK.

[1217] @7 AN Clip FICRFIR K LTS T R A 2N B2 AT WL

[1218]  RenderTransform [JGZ

[1219]  MatrixTransform @&Xf G2 0] H RME— 22 @ 1t . B RIE T 5% . 7kt
[1220]  <X. RenderTransform>

[1221] MatrixTransform Matrix =" 1,0,0,1,0,0” />

[1222] </X.RenderTransform>

[1223] X FoR o] HLR I AR #R K T 2R o

[1224] Matrix BHPIEEH /ST 2 m00. m01.ml0 ml 1. dx. dy.

[1225]  SEEEAERER LA

[1226] m00 mOl1 O

[1227] ml0 mll O

[1228] dx dy 1

[1220] 257 ALFR XY RN H] AR oH 5 RenderTransfrom 28 #e A= T3 I ARAR X
Y

[1230] X' = X*m0O0+Y*m10+dx

[1231]  Y' = X#mO1+Y+*ml1+dy

[1232]  OpacityMask 0%

[1233]  OpacityMask 85 T fill+ (Brush) , {H2& S3E M+ (Fill Brush) #HJ, {548 Al
T o @IE (W B Opacity @) /EAH T 2MTHZBIM MBS, TENE—BEN
B— o HRFHAIME Y Opaci tyMack il 7 HH IR N A B AL o« {HAHRE.

[1234] <Canvas> JUH

[1235]  <Canvas> JTEH TR TRAGE L. BE, Qe mcmEZH440 AR
P (B[, Opacity. Clip. RenderTransfrom ¥ OpacityMask) B}, EI{E <Canvas> PG
B, B EmAn B IX S n RGeS, 8 v e 1 Y 21 A7 i 350 1)
JLE.

[1236]  <Canvas> HJJEMF1F 0z

[1237]  <Canvas> JU 2 H B L ar i iR 17~ H )8 1 :Opacity. Clip. RenderTransform Fl

OpacityMask. ‘EA1a N R AR T <Canvas> JUE :
[1238]

Je Tk R AR _ERIRCR
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59/81 T
Opacity o SCIH| AR 3475 375 B
[1239]
TIUE T A _E AR
Clip Clip #& T A i Canvas [
T 0 E ) H Y I 1 DX
o
RenderTransform RenderTransform A HI A )
FICE A T WA AR 4
g, 40 o — A . AN S HF
MatrixTransform,
OpacityMask f&€ T LA Opacity J&1E
AR T AN I« (B
FETEHERL, (H 2 RTIER
FEM EAFK o i,
[1240]  DARARid/RE7R it T4 <Canvas> FIfEH .
[1241]  <Canvas>
[1242] <Path Fill =" #0000FF” >
[1243] {Path. Data>
[1244] <{PathGeometry>
[1245] {PathFigure>
[1246] {StartSegment Point =" 0,0" />
[1247] <{PolylineSegment Points=" 100,0 100,100 0,100 0,
0" />
[1248] {CloseSegment/>
[1249] {/PathFigure>
[1250] <{/PathGeometry>
[1251] {/Path. Data>
[1252] {/Path>

[1253] </Canvas>

[1254] X T AT AR IC A LU, % LA WA . anfi 2 v —#F, /5 7F Canvas
[¥) Glyphs ¥ JC 2% I BRICNR T 06 2005 ST AR Py 25 0 B S8 1 DO A8 [R] o 122152 UM 0 200 FH -+
ok B2 A P IR e T 0 S RS B RE / =, DR SRR AT U el PR AR U
SCAIRI T 1] o AR PRAR C P RS OGP 22 T 49— o A A A o ] 5 D T b 1 PR B FH R

KBTS

[1255] L& FEIREN Canvas JUE W Glyphs F o3 AE L ILAE Canvas Z HIAIZ J5 ) 0l

#5 Glyphs JEEZ A ik
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[1256]
[1257]
[1258]
[1259]
[1260]
[1261]
[1262]
[1263]
[1264]
[1265]
[1266]

ZN/IIE
<{FixedPage>
<Glyphs...UnicodeString =" Now is the time for” />
{Canvas>
<Glyphs...UnicodeString =" all good men and women” />
<Glyphs...UnicodeString =" to come to the aid” />
{/Canvas>
<{Glyphs...UnicodeString =" of the party.” />
<{/FixedPage>

<{Path> JLE
Path JCEEfEA J LA XA EET XML e ER. JU X80 nT g 3a 78, sl vl A

FBT AR TR . U W RS RN 52 TR 25 7 L 1) LT 4 R R0 w] DIATE ) B 4% T L AT 45 i ke 36
TNo MERIHIL YR E T E 1 Geometry. Data F-JCEAMIE W Fill B¢ Opacity SEiE 4 8 MK 4

e

[1267]
[1268]
[1269]

[1270]

<Path> BB MR 0E

PR @ PERE ] R SCHER I <Path> JUE -

JE Tk 7E Path _EISCE
Opacity SE ST T AR R
A
FItE 1F Path F R
Clip Clip #i& T n] 421 )L
AR 2 ) N FH Rl 16 X
i
RenderTransform RenderTransform A & 4% i
FICE BN T AR bR g

), U Path. Data & X ¥
PRCET NS &5

MatrixTransform,

OpacityMask {82 TULS Opacity @
FEE 7 NI o B
FETEHERL, (H2 RVFATER

TR AR < B A @ fE.
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Tor= 1E Path F 2R

Data R T A2 1 LA S5 44 o

Fill R T H 6 AR LA
LR T .

(12711 AR Q5 B <Path. Data> I8 KL S5 R IR 1) X 8805 (5, A T Fill )8
Mo RBREIRIAEIL F 2] <Path. Data> ARG, 4 T Clip J@ M.

[1272]  f§7H] <Path> KA JIAT 54

[1273] & 42 1) JLAAT &5 44 $% F5 72 & <Path. Data> B — R ¥k E F 02, WK X 7R
JUART &5 #4 m] DL AL & — 4 <PathGeometry> T JC 2% HJ <GeometryCollection)> BY £ &
<{PathFigures> B4~ <PathGeometry> T JLZKE o

[1274] <{Path>

[1275] {Path. Data>

[1276] {GeometryCollection>
[1277] {PathGeometry>
[1278] {PathFigure>
[1279]

[1280] {/PathFigure>
[1281] <{/PathGeometry>
[1282] <{/GeometryCollection>
[1283] <{/Path. Data>

[1284]  <Path>

[1285]  AH[FH) <GeometryCollection> BY <PathGeometry> JLZ E X T H T3#kEI Canvas.
Path 8 Glyphs [#) Clip J& A 40 H B A2 1 J LT 45440

[1286]  LLRNRKGAH T € AR LAT S/ 0 R N5 2 455

[1287]

YIRGEST VIS Eiiipu

GeometryCollection 1% A BooleanCombineMode #:/E 231,
H)—4H PathGeometry JLZ .

PathGeometry HAF— Ay A FER FillRule Sk INkIE
FEM¥)—4H PathFigure JGZ .

PathFigure —AEENFBITTENES.
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YIRCEST AP it pun

StartSegment
PolyLineSegment
PolyBezierSegment

CloseSegment

[1288]  GeometryCollection

[1289]  GeometryCollection s& —ZH A% 2H A 7F — L KA BE AR /K CombineMode &7 2 DL
JUFT S 5 0 GeometryCollection JTF & & UL bRic - H T J LA AR B rT AR AL &
B o

[1290]

B 1 GeometryCollection b2

CombineMode |fg& T H T & LT EHA R A

[1291]  CombineMode @M +5 %€ T H T4 & GeometryCollection A [ —ZH JLAAT ALK ) A
IRBAE . WRPREI, ] AL HE BHERRAS R 1 X 55
[1292]

CombineMode &I iR

Complement FE0E T IA DX AT DB B B A X IR 25 Aok
o 5 2, NP HEBR LA X 5,

Exclude TR T A DX S IR DX 3 A e DX Bk 5 3ok
o #0522, WA DX A HERR BT X 4

Intersect BB AT R A XA A

Union THBOFEREMA XA A

Xor B PCR A BB AN RS, (HAE AN X B

B R A A

[1293]  CombineMode %1 R AbFE .

[1294]  AwB[AT#: Complement Fll Exclude A& R AT # ), K IHAE GeometryCollection
[R5 — A JUART 5 e R AE— AN 0 R e 4% JLART S5 4 2 TR g o i, X T35 (g1, g2, g3},
Exclude i CombineMode ¥4 HI 4 ((g1 HERR ¢2)) IF H. (gl HERR 23)) .

[1295] W] AZHeAf /R #4E Union, Xor. Intersect J& W] AT # /), BRI 5 M7 o e N H T L
(EEET AP
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[1296] PathGeometry

[1297] PathGeometry JG 2% 4 & — 41 PathFigure JG 2. PathFigure ) JF 2 X T
PathGeometry BN HE -

[1298]

& Mk 7E GeometryCollection %A

FillRule g T T HTe I P DB R AR IR R RS

[1200] ¢ T FillRule J@1, % B LL NN 4. PathGeomerty FUHH 78 X 3802 i i SR H 44
Filled J& ¥ A BT A L5 1) PathFigure, 37N A FillRule SRHA & F1-A X ok & ST
FillRule IR E T 41T Geometry WAL ¥ Figure JuZ HIAHAZ X A A 7E— & ¥ ik
Geometry ¥ FTTFX 15,

[1300]  fi B B 4 & (1) 55 il 1, $& {7 A f8 3H /8 (EvenOdd Fill) A1 HE & IH 7
(NonZeroFill) &k,

[1301] T RIH AR EEE AT B — S B E—T7 1 ERJEST KEIST2R, AR A
2 I ZST TR B i B2 A s SR 8 Z s N7 o MTHECE TG, ZE B0 BRI N
— A IZS I B IF NG B e SRRk 2 — A Sz i & B A v B R %k
T AL WHZ RAE NS 15 W, i ARSI

[1302] FAEFIH AR EEE 2N AT ER— B E—T7 7 ERJEST KBS 2R, FEAmzsT
S T2 2 TR I B8 A2 BEEEAT VHE SR e & ) “ IR . FEXT g ATV
o, MAREE R 0, WHZ R AERRATAM . W), X R AE .

[1303] PathFigure

[1304] PathFigure T HWFE PR EZ N LB BMEBRNESLG. GBRTEEXLT
PathFigure 2R, PathFigure 240 52 2 X W& IR

[1305]

& 1F PathFigure [

FillRule g T T ITE IR P DO R AR I R RS

[1306]  EIJE R LR A, Z et — 2B sl B BN N B s — A Rigk4E. PathFigure
L PR — B SE StartSegment, [ CloseSegment Wi )i — B . StartSegment
HA Point J&1E. CloseSegment WA @M.

[1307]

StartSegment J& I [fiid

Point B ORI M E.

[1308]  fIT: Path. Data JL{o] &5 £4) ) [ 2 A R #bn il
[1309] DAL T H T2 W FFE 7w mAm L2 Fric. 76 AR BARR g, 76 AT L
LI AR, 4 g ) FoRIE 7T .

68



CN 1961304 B WO B 64/81 7

[1310]
[1311]
[1312]
[1313]
[1314]
[1315]
[1316]
0" />
[1317]
[1318]
[1319]
[1320]
[1321]
[1322]
[1323]

{Canvas>
<Path Fill =" #0000FF" >
{Path. Data>
{PathGeometry>
<{PathFigure>
{StartSegment Point =" 0,0" />
<{PolylineSegment Points=" 100,0 100,100 0,100 0,

{CloseSegment/>
<{/PathFigure>
<{/PathGeometry>
{/Path. Data>
</Path>
</Canvas>
LU RicHE 7425777 Bézier k. B, B PolyLineSegment (#T4kB ) Z4h,

[ 72 A A BRI B RS T4 57 77 Bézier HIZRH PolyuBezierSegment.,

[1324]
[1325]
[1326]
[1327]
[1328]
[1329]
[1330]

0,0" />

[1331]
[1332]
[1333]
[1334]
[1335]
[1336]
[1337]
[1338]

{Canvas>
<{Path Fill =" #0000FF” >
{Path. Data>
{PathGeometry>
<{PathFigure>
{StartSegment Point =" 0,0” />
{PolybezierSegment Points =" 100,0 100,100 0,100

{CloseSegment,/>
<{/PathFigure>
<{/PathGeometry>
</Path. Data>
</Path>

{/Canvas>

il 1~

il F T4 B <Path> Ju g & X LFTTER I N BT & (4, IFH A <Glyphs>

JTUEEMBFZAFAE . BTt H T2 X <Canvas. OpacityMask>. <Path. OpacityMask> F/l
<Glyphs. OpacityMask> H [ a JFEAHPEREA, & @ 00 b ic LG BT ml5- -

[1339]

il 72 Y it pan

SolidColorBrush FHaf L IH 78 2 R LR X 38
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iyt ik
ImageBrush FH EMGIA 78 X 45
DrawingBrush MR EEIARX .

LinearGradientBrush | &k M BEHE 75 X B,

RadialGradientBrush |FH4% ) B 75 X 3.

[1340]  J&PEAE & Ml + 2 [ AR AL, & BT (R #F 2 A Opacity J& . ImageBrush Fi
DrawingBrush L5 Borfe Jy. W HBREIE AR 7 2HA 2 I E .

[1341]  xPhrid il oo =R H T -

[1342] <Path>

[1343] {Path.Fill>

[1344] {SolidColorBrush Color =" #00FFFF" />
[1345] </Path.Fill>

[1346]

[1347]  </Path>

[1348] il A

(13401 IR Fratidd () S, LA e P F T By il 57, BR il 41 5~ SolidColorBrush
A, E HAT DI AEE T oUE .

[1350]
JE Tl -2 B | H R
Opacity |FA i+
[1351]
TILE il -2 1 £y
Transform BT £, i T N H T AL bR

SolidColorBrush 2 #h &%) ISR REAS #

[1352] ] T DrawingBrush f ImageBrush [ BN
[1353]

HorizontalAlignment |DrawingBrush. ImageBrush Center. Left 8% Right

VerticalAlignment DrawingBrush. ImageBrush Center- Bottom &Y Top

ViewBox DrawingBrush. ImageBrush

70



CN 1961304 B WO B 66/81 7

HorizontalAlignment |DrawingBrush. ImageBrush Center. Left 8% Right

ViewPort DrawingBrush. ImageBrush

Stetch DrawingBrush. ImageBrush None, Fill, Uniform &
UniformToFill

TileMode DrawingBrush. ImageBrush None, Tile.FilpY.FilpX g%
FilpXY

ContentUnits DrawingBrush. ImageBrush Absolute %
RelativeToBoundingBox

ViewportUnits DrawingBrush. ImageBrush Absolute 8%
RelativeToBoundingBox

[1354] HorizontalAlignment ( ZKFXFF) JEHEFRE Tl -+ Wi 76 € Prid 72 X 3 P /K
X5 VerticalAlignment ( HEEXTFF) BMEFe € T il Wi 72 & Frin sm i X sy 5
X575, ViewBox J@ M HAEINME (0,0,0,0), #ifdRE N RiRE . ARBEN, AMEHALFATV
#, JF HZmE Streteh J@E. SENE (ViewBox) NN AIRE T bR S, I, S5 E X T
2E 1 (ViewPort) FVERHIAIR . Stretch (Hhrf ) J& M35 Bhfe e HS L phy 25 fnfrf i i 31| %2
FH . Viewbox J&MERIME VI “ T HAL” 0 <min—x>. <min-y>.<width> Fl <height> [
I, G / BUZ 5 40 B%, F Ho& Rect KU, ViewBox rect ¥giE T Wb 2ITAAE R FH -
FIRPRRE . B 5 scaleX #l scaleY —HEEAEM . Stretch @ (FEETAFE Tk
TR OL R ) A T TR R B 06 LU I B Indss il o BN A2 4 i 2125 72 ST = I e
TINCE, LLIARIFR ERR . B AF Brush A, W'EAE ViewBox MR« F7 N .
[1355] Stretch B HEHALL IR :None. Fill. Uniform. UniformToFil.,

[1356]

Stretch @MEED  [HiiA

None Boho TRREIELG KN
Fill AMREFRTE L, I HA6700 258 CUE 8 7 138 5
Uniform VIS AE ORI BB EHGIE A AL 7

UniformToFill B HAR BRI SRR i (1A 5, I E 77 B Y

[1357]  faj & hp| 1 M FLE Pk
[1358]  Path. Brush Hll Canvas. Brush F e 23 f$5LL T :SolidColorBrush. ImageBrush

DrawingBrush.,

[1359]  SolidColorBrush HIZi(IHTEE AL Xtk AR R o 73, WPRE A
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FFR 7 A Brush Hxf A IE PR A 5 .
[1360]

Btk (BR

Color |HHFE LR T E I L

[1361]1  LAF/RBI7RH T @i X SolidColorBrush FRIAENE & VE .
[1362] <Path)>

[1363] {Path.Fill>

[1364] {SolidColorBrush Color =" #0OFFFF” />
[1365] </Path.Fill>

[1366]

[1367] </Path>

[1368]  ImageBrush o] H T HEGIH A2 0] ImageBrush Mpric LA FEE URL. TR
e B At e A FLER AR, WD 7 o A5 LU 78 X R T ALE

[1369]

J& T R

ImageSource |$87%€ T B % YHH) URT

[1370]  ImageSource J& L5415 | I SCHF IR Bk B Gbs Xz — BUBAT X L6 A 7 — (1 K5
[ — RS

[1371]  DrawingBrush ®] F T H] %< & K KIH 78 4%[8) » DrawingBrush H A5 Drawing 0%,
HAFHAE L R R AR e

[1372] <{Path>

[1373] {Path.Fill>

[1374] {DrawingBrush>

[1375] {DrawingBrush. Drawing>
[1376] {Drawing>

[1377] <Path.../>
[1378] {Glyphs.../>
[1379] {/Drawing>

[1380] </DrawingBrush. Drawing>
[1381] <{/DrawingBrush>

[1382] </Path.Fill>

[1383]  </Path>

[1384] £ il I

[1385]  BREEIED R — AHBLEAE A (stop) FR7E ABE R IK XML J- 050k & Hl. X LEHE
AT R —IATIE R E T . AMEZ P SCREP A SRR OB BRI 1 R PERIAR 1
(13861  #ofi J& /2 8 i A fi5 22 19 U652 1) A 1) B 645 o 2 TR 58 A AT O O 4 7l
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LinearGradientBrush f RadialGradientBrush FLZ LR A JB@ 4
[1387]

J& Tk ElHipa

SpreadMethod SRR T B AT S 7S R WTAE R R X I MR P
Xk, BRIAE S Pad(#[3H) .

MappingMode 2B R R A A TR G I T RE R R R IR B R I B4, BR
PMH 2 relative—to—bounding—box ( FEX T344E ) .

[1388]

TIUR Eit:pan

GradientStops |&4 GradientStop JLE M EHFETFA.

[1389] X} T SpreadMethod J@ M, Z ELL NN & . SpreadMethod ZEIFE 2 T Wi IH 78 &
). BRIAME 2 Pad.

[1390]

SpreadMethod J@ kTN |[4F Gradient 2R

Pad SR — IR S n — D EUE R B TE R Ih A
ANl FR AL AR A% DX I

Reflect 2 P 15k AR B I APy o 2 M EE ORI 25 )

Repeat 2N 2 20 P A s L BIATE T A5 (A o

[1391]  MappingMode &%
[1392] X T LinearGradientBrush, % & LA N M 4. LinearGradientBrush $8/& T #i—2%
SRR R R T

[1393]
JE ik
EndPoint HPERAE 2 5, LinearGradientBrush
M StartPoint (42 /5 ) %] EndPoint ( 2&)5)
WHEEIE, Hoi StartPoint Xm0,
Tl EndPoint #RmE 1. BRIAZE 1,1,
StartPoint LR MERE AT 5

[1394] DU FARIC/ARHIZRHE T X LinearGradientBrush W H . AR EIHA T HA M
TE A2 DL -
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[1395] <FixedPanel>
[1396] <{FixedPage>

[1397] <{Path>

[1398] <Path.Fill>

[1399] {LinearGradientBrush StartPoint =" 0,0” EndPoint
=" 1,0" >

[1400] {LinearGradientBrush. GradientStops>

[1401] {GradientStopCollection>

[1402] {GradientStop Color =" #FF0000” Offset
=" 0" />

[1403] <{GradientStop Color =" #0000FF” Offset
=" 1" /5

[1404] {/GradientStopCollection>

[1405] <{/LinearGradientBrush. GradientStops>

[1406] {/LinearGradientBrush>

[1407] {/Path.Fill>

[1408] {Path. Data>

[1409] {PathGeometry>

[1410] <{PathFigure>

[1411] {StartSegment Point =" 0,0" />

[1412] <{PolyLineSegment Points =" 100,0 100,100 0,
100" />

[1413] {CloseSegment/>

[1414] </PathFigure>

[1415] <{/PathGeometry>

[1416] </Path. Data>

[1417] </Path>

[1418] <{/FixedPage>

[1419]  </FixedPanel>

[1420]  ZoRfls T F St B T i) A SR B AR 10 D o A2 33T e 1 A TE I
TER WA BB 1.

[1421] <FixedPanel>

[1422] <{FixedPage>

[1423] {Path>

[1424] {Path. Clip>

[1425] {PathGeometry>

[1426] <{PathFigure>

[1427] {StartSegment Point =" 25,0" />

[1428] <{PolyLineSegment Points=" 75,0 100,25 100,75
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75,100 25,100 0,75 0,25" />

[1429] {CloseSegment/>

[1430] {/PathFigure>

[1431] <{/PathGeometry>

[1432] {/Path. Clip>

[1433] {Path.Fill>

[1434] {LinearGradientBrush StartPoint =" 0,0” EndPoint
=" 1,0" >

[1435] {LinearGradientBrush. GradientStops>

[1436] {GradientStopCollection>

[1437] {GradientStopColor =" #FF0000” Offset
=" 0" />

[1438] <{GradientStopColor =" #0000FF” Offset
=" 1" /5

[1439] {/GradientStopCollection>

[1440] <{/LinearGradientBrush. GradientStops>

[1441] {/LinearGradientBrush>

[1442] {/Path.Fill>

[1443] <{Path. Data>

[1444] <{PathGeometry>

[1445] <{PathFigure>

[1446] {StartSegment Point =" 0,0" />

[1447] <{PolyLineSegment Points =" 100,0 100,100 0,
100" />

[1448] {CloseSegment/>

[1449] {/PathFigure>

[1450] <{/PathGeometry>

[1451] {/Path. Data>

[1452] {/Path>

[1453] <{/FixedPage>

[1454]  </FixedPanel>

[1455]  RadialGradient (£2[r) B AL ) £E4m FRAE RS o 5 St Bl BEARBL. SR, e 1t 2 AL
A8 SUHR B O S i P R, T A2 o) 6 P AT (B8] o DA R s ok vE SUBBFEAT o [ 5E X
TR - 5 22, 1.0 WBR BE A RUE SCT R R A A B . B RUE T RREERT D
0. 0 AR AL RE T A R .

[1456]
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J Tk EiHipaN

Center 1ZAR MR 0 5, RadialGradientBrush MAE & 2IHE R 1) B 5
WHEEI . JA LRk e . BRI 0.5,0. 5,

Focus 12 1) Ao FBF F) R
RadiusX T8 SUAR e A6 S ORI 1) X 442, BRIAAZ 0.5
RadiusY TSR BRSO ) Y 4E-42. BRIAAZ 0.5

FillGradient [Pad.Reflect.Repeat

[1457] o FUEEHE

[1458] K HE T/ G R B) SE T, B — o= R — R B EHE M 0. 0 (582E] ) 2
LOCSERAZEY) B a . HREICE VAR RE P KA ORI, AT o {E.

[1450]  fp—Jum ] A Opacity (AEHME) B, TR —GEN o B 5ZENT
PSR

[1460]  5j4t, OpacityMask SRVFFRE &R R KA Z M, ©HEHIATH 2L N AR
GBS, H OpacityMask FREMAENME S AR EANAEN o WIEPAFAERAEAT
ANFEH M VLR A . H OpacityMask ¥8 @ I RF—1% & [ Opacity B A s rp £ —1%
R o HIERHE — 288 E R .

[1461]  OpacityMask [{)2R7J2 Brush. 3X fSi4r4e a2 Wil LS FPAS [ (1) 7 20K Brush (19 4
P BN N BTG o W THE 78 J LTS5 R0 FE , Brush BRI IH 78 3EAN Py 2527 (8], 7038 4
IR B R AL N Ao X AR BEGORIK R AL 5 R LLoE 4 78 o5 8 2% 1R B IR A 32
AR

[1462] o VRETFEREEALSLHT “Opeity BIE” — PRk

[1463]  LLR/Rfl7mth 7 Wl di A OpacityMask 7E Glyphs o BAIE “HT998CR 7. AR
B Hh ¥ OpacityMask J& MANIZ BH (1) 5857 55 20575 B 160 2B I 2R PERR S o

[1464] //  /content/pl. xml

[1465] <FixedPage PageHeight =" 1056” PageWidth =" 816" >

[1466] {Glyphs

[1467] OriginX =" 96"

[1468] OriginY =" 96"

[1469] UnicodeString =" This is Page 1! ”

[1470] FontUri =" .. /Fonts/Times. TTF”

[1471] FontRenderingEmSize =" 16"

[1472] >

[1473] {Glyphs. OpacityMask>

[1474] {LinearGradientBrush StartPoint =" 0,0"” EndPoint =" 1,
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0" >
[1475]
[1476]
[1477]
=" 0" />
[1478]
=1 1" />
[1479]
[1480]
[1481]
[1482]
[1483]

{LinearGradientBrush. GradientStops>
{GradientStopCollection>
{GradientStop Color =" #FF000000 " Offset

{GradientStop Color =" #00000000 " Offset
<{/GradientStopCollection>

<{/LinearGradientBrush. GradientStops>
<{/LinearGradientBrush>

<{/Glyphs. OpacityMask>
</Glyphs>
[1484] </FixedPage>

[1485] B IE SOk ) IR

(14861  {E[E E U b, BRI R T PG X3 Ak GO 76 [ € oo, & Se b e it
i EiRE X . X H Path JCR LT SRR E o

[1487]  Path JUHRM Fill J@hde 2 T iR i I IH A8 WA . BB R IH A —Fh 2k
AL, oy R B X B o TR R 5 BB BIAT b 24T Rl AR G I e R
PR Bl N A RIA R A X 72 BRSO T 5 B ImageSource J& T Fi5 i I N 2504
e LA e 427 i 1% X 8

[1488] LU RAmicasth T 4k G0 ) m A L

[1489] {Canvas>

[1490]
[1491]
[1492]
[1493]
[1494]
[1495]
[1496]
[1497]
[1498]
[1499]

[1500] </Canvas>

<{Path. Data>

{GeometryCollection>

<{/GeometryCollection>

<{/Path. Data>
{Path.Fill>

<{ImageBrush ImageSource =" /images/dog. jpg” />

{/Path.Fill>

[1501]1 T2 BGRMN, SRR 7 L 15 B 12 o0 RAE R AR T & A H
1. #4285 {f H RenderTransform J@ ke ( W E3C) .

[1502] {Canvas>

[1503]
[1504]
[1505]

{Canvas. Resources>
<{PathGeometry def:Name =" Rectangle” >

{PathFigure>
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[1506] {StartSegment Point =" 0,0" />

[1507] <{PolylineSegment Points = 100,0 100,100 0,100” />
[1508] <{CloseSegment/>

[1509] {/PathFigure>

[1510] <{/PathGeometry>

[1511] {/Canvas. Resources>

[1512] {Canvas>

[1513] {Canvas. RenderTransform>

[1514] MatrixTransform Matrix =" 1,0,0,1,100,100” />
[1515] {/Canvas. RenderTransform>

[1516] <{Path Data =" {Rectangle}” >

[1517] {Path.Fill>

[1518] <{ImageBrush ImageSource =" /images/dog. jpg” />
[1519] {/Path. Fill>

[1520] {/Path>

[1521] {/Canvas>

[1522] </Canvas>

[1523]  Eifh

[1524]  E(AA] LAZE BT 7R IR PR L A H scRGB B sRGB R 72K 45 € o scRGB ML
FRA “IEC 61966-2-2scRGB”, 3 HL.7J M www. iec. ch k15,

[1525]  ARGB Z4U{E F R HiAk.

[1526]
2B ik
R MHTEUE L scRGB 73 &
G HHTENE Sk scRGB 7r &
B MRTEUE IS scRGB 7 &
A METEE ) o scRGB 77 &
[1527]  Bifa it

[1528] 44, F k& T HIR @B st o fidi kX oo = bre . oo 8dE i a7 1CC
PN D B B B B

[1529]  <Glyphs> JU %

[1530]  SCARFE[ 2 AT A Glyphs JUER KK %I R B VTG 2 H T4 Ep
FHBIIA ORI 77 K

[1531]1  Glyphs JuE Al R AT @45

[1532]
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J& H 1 Frid &7~ (Glyphs JT
=)
Origin TR R — IR R S E S H OriginX
B, I AT S B RTHY M HLEE LR |OriginY BYEFRE
5% SAEAE
FontRenderingEmSize |PAZ |2 [ FoA7 RN TR CER [HKBE B A kel &
NA 1 ZEF ) 1/96)
FontHintingEmSize PERE NS RN PR AEERL  (F R AR5 E
ANFI RN = AR Al 22 S g 7, 1 RUKE B 7 e ) =
BRI RLR R ST 5 /N B T T
@i (bowl) , LAF=AF X H )
Aigg iU E (can) WAHEFEA . IX
NG T &G E 5 PR A
A, & Aahib#., 245 K1k (2003
H3H) WA MRS R
TNo BANEN 12 B
GlyphIndices RINZATIEN 16 LU 55 Indices J@ M H—#B
7o R IR R.
AdvanceWidths B (advancewidth) %04, %t Indices J& M) —#B
GlyphIndices FIF—FEH —1. |77 WFXHIER.
ATRFE n(n > 0) MR LR
RUE -1 NI A R S Eds
ATFERTEER B I 2E n—1 AHTdE s
B
BEARLE— R BEFHAEZFR AT,
HEMFE—R BEAZETE e,
GlhphOffsets FIAMBEA . SN ESCHERIA  |Indices JEIER— &6
SCF TG LA B T ) e 28 D e W IR R,
FHu R — K EA (0,0) MTFEWE,
HEF R EA B EAER R
BAE BT P ET 3550 B R
%o
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J& 1t

ER:Y)

Fric®~ (Glyphs JT
#)

GlyphTypeface

ML BEE B ZATRE P IR T 7
TERIELFAE

FontUri.
FontFaceIndex fll
StyleSimulations J&
a3

UnicodeString

ATk

I FTRATFER R I E R 44

* VER X T A Win32 4T EPHLIKBh 2
FEAE B GlyphRun, 540 Win32
ExtTextOut (ETO_GLYPHINDEX) iff
FATER SRR AR IS B B PR R
SITBEH Unicode B A IIRENFEF o

=

FEIRX GO0 T, AR P ART, B
J A3 () GLlyphRun i %6 45 i 1
Fo HITERAT A e A HE A
H B DI B R SE D REA
AP RSO SR OREF AT RE

ClusterMap

XJ Unicode A H IBF— 45— 4%
H .

—{E4H T GlyphIndices &R
Unicode H X WA FRF 15— AT
IR -

2 AR B AN TR, B
M FRFIRI B Z A, BiE 24T
FEANH] DL S 21 2 AT, —AS
MENFRFUL—ANBEN IR
ClusterMap "' H T2 F R EFEE )
A 4% B W BRI EE — TR
GlyphIndices 2040 IR FS o

Indices J&MH—#&
e WH RN
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J& H 1 Frid &7~ (Glyphs JT
=)
Sideways FIAE L — A . =

ERUAHL, FIE A R IA B AT KT 3L
A, FCJg RN R TP S HE 2k S R

WERVCE T 55 bn s, W PR —
0 _E A 1], Jit oA R T I I

s,
BidiLevel Unicode VL) bidi kEH . LT
=
ARBAER R T MAERNAA AR R AR
B BB AR R T WA BN ZEAT SR
W B LA R OB AT FR A 70 v AE 2R
— I, FRTUE R B ) R,
N = S e TR | AL pase v
Brush T2 ® T T sTl M ShapeFill J@
PRI
Language ATRERTE S, Bk BAric ) H xml:lang B PETE
xml : lang J&@ 7 . %o

[1533]  SCAMRICZEIA
[1534] FEEE
[1535]  fp—FJEoE X T 8@ & W 5 H e T TR 55 1 R o A — AN S A3] F) 7 451 1 P2
B 12 hoRH.
[1536] REiEEw/EMAESILS
[1537]  — &M &, FARW T & 2Rl T2 slnT B 2256l TR A G id 5. 5l IE
W HAAEERRTE R, DU 0,0 KM k. Al G id 5l A Fard s, wmig
R H TR S0 T A E, JF BRI A 50 5 A HE 0,0 {8
[1538]  FIATHEF B — AR A EH AL B I =AM XL TR/R T BTk 56
M mt , R — PR T -
[1530] @) ri B —FIEARUEL T — 4% R =5, M TATE PRI — I8, R RATIER
JH Ao
[1540]  @HIETE L B FIRRIRTE R IRt TR — AN T2 R AR Al /T
EOR B S AR AT R 2R 1K 77 1) 24
[1541] @FIBImEE (FEREEGL S ) I R EAN T H A R sz 2 A E .
[1542]  “F4F . FIEFIRFEE I
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[1543]  BEEEWLG X BF— Unicode B il — 14 H. 4 BT HIMEAZ GlyphIndices 24
hRIZE S — N R . B, 68 R — AR OR AN W R R AR B8 R —
#3I, GlyphIndices ZALH B — DN FIERRRAXBER I S — DA IR IR o

[1544]  BEAEMLER

[1545]  FEAEWLGT AT SRR A — FIRBRES, Bl L@ —X— X — W ZHEN L. —
X Wi R A A — R R R, B 13 PRI 25 H A2 011,200 000,

[1546]  ZXf—BREZ A BRE AN s LS B AN . IR & Ba e T 2R RG]
G XX P IRES o 7R 14 BB, £ F1“1” PR AIES (ligature) SR #R, 1X
TEVE 24 2R 2 WL HE 10491

[1547]  XIT— X Z WS, 45K 5 HIELL N W . “Sara Am” GE A7 T /o AT BIZEAE 7 7F
(F1 ) EJ7 5y, LA AL TIERE2RF (A) A RES 4 o a0t 28 SCOCATEAT RO I, 45
A 5 IR o T AR B AR SR AL R BT, TR 2 S AR BRI G B Sy BRI
TEo — A0 S BN A 8 2 AFIERT, %05 50 ClusterMap ( BESERRES ) F A 5] H
GlyphIndeces £ T RN LI S — T

[1548]  XI T Z X Z WG, 4561 16 HELLIN A . B2 hrh, ARIRFEN —AAT]
A5 R st B — AN CL BT . B, IR AR SRR B TR AR K A A b W RN
DAG s B — A B Z AP ITEN, B9 S ClusterMap FP{E S| H GlyphIndeces 41
SR N ALY SN N i pe N

[1549] DA R RBlzn e T 28K /R BiAGuUId () Unicode PR R RIS sS4l & 76—
HELUE R =T

[1550] R EHEEE

[15511  BFAERLVEAL TAE 10 L BRI AR — NP IR INE (RS B — A R0 — T g
BHEHR) .

[1552]  fF—HFEMIEHALLFER .

[1553]  (ClusterCodepointCount[:ClusterGlyphCount])

[1554]

it S MR ) e H ERIME

N

ClusterCodepointCount|IF¥8%L | &AL OZEEERT 16 Leky 1
Unicode 4 S HI# &

ClusterGlyphCount IEES  |AEAE—EUIESOZEEER 16 LEEE 1
FIRG W=

[1555]  <Glyphs> #nid

[1556]  Glyphs JCEH P ATEE AN URLRE RS —4 FiREH e E . #lhn .
[1557]
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{Glyphs

FontUri =" file://c:/windows/fonts/times. ttf”
FontFacelndex =" 0" <! —-Default0 == >
FontRenderingEmSize =" 20" <! ——Nodefault—>

FontHintingEmSize =" 12" <! ——Defaultl2—>
StyleSimulations =" BoldSimulation” <! ——DefaultNone—>
Sideways =" false” <! ——Defaultfalse—>

BidiLevel =" 0” <! —-Default0—>

Unicode =" ..."” <{! —Unicoderep—>

Indices =" ...” <! —Seebelow—>

remainingattributes. ..

/>

[1558] Hp—EIEAEALUTFEL

[1559]  [GlyphIndex][, [Advance] [, [uOffset] [, [vOffset][, [Flags]]]]]
[1560]  “FTEHISE BB — & 53 A PR IE 1T

[1561]

FIEHTE 3 H 1 NN
GlyphIndex S H AR R E IR RG] LT P SO H X
I Unicode i s (24
FARFWICE 2 i e X
Advance T IEAR AT B R e R i AR HMTX B8X
1/ Sideway 1 BidilLevel J@M & XIIHT [VMTX A EEE
by )i PEiP

AR em K/ 1/100 P&
WA ST HE, A3 NIRE A2 R
ILELR S8 AT IS 2K — ZR TR RE

uOffset. vOffset |#HXf IR S K WE U 8% T . 0,0
T H H T80 5 MBI aE 255
K em K/MR 1/100 0 & .

Flags DAFEA A SIS 0 ( ZAli )

[1562] X Pit&EardimEa S AN RERER, BB THNE . B E LAt 5o )G
KM FR RSN R E LR RO E (B, Od ) ardk s am. DUy,
Tg—F A e B DI B 0. 5% em Z o
[1563]  “FiEAnic
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[1564]

{Canvasxmlns =" http://schemas. microsoft. com/2005/xaml/" >

<{Glyphs

FontUri =" file://c:/windows/fonts/times. ttf"”
FontFaceIndex =" 0"
FontRenderingEmSize =" 20"
FontHintingEmSize =" 12"
StyleSimulations =" ItalicSimulation”
Sideways =" false”

BidiLevel =" 0"

OriginX =" 75"

OriginY =" 75"

Fill =" #00FF00”

o

UnicodeString =" innertext...”

/>

<! —' HelloWindows’ withoutkerning—>
<{Glyphs

OriginX =" 200"

OriginY =" 50"

UnicodeString =" Hello, Windows ! ”

FontUri =" file://C:/Windows/Fonts/Times. TTF"”
Fill =" #00FF00”

FontRenderingEmSize =" 207

/>

<! —' HelloWindows’ withkerning—>

<{Glyphs

OriginX =" 200"

OriginY =" 150"

UnicodeString =" Hello, Windows ! ”

Indices =" ; ; ; ; ; ; ; ,89"

FontUri =" file://C:/Windows/Fonts/Times. TTF"
Fill =" #0OFF00"”

FontRenderingEmSize =" 20"

/>

<! —' Openfile' without’ fi’ ligature—>
<{Glyphs

OriginX =" 200"

OriginY =" 250"

UnicodeString =" Openfile”

FontUri =" file://C:/Windows/Fonts/Times. TTF"”
Fill =" #00FF00”

FontRenderingEmSize =" 20"

/>

<! —' Openfile’ with’ fi’ ligature—>
<{Glyphs

OriginX =" 200"

OriginY =" 350"

UnicodeString =" Openfile”

Indices =" ; ; ; ; ;(2:1)191"

FontUri =" file://C:/Windows/Fonts/Times. TTF"”
Fill =" #00FF00”

FontRenderingEmSize =" 207

/>

<! —' & XU KBTyMaHe' usingpre-composed’ &' ——>
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<{Glyphs

OriginX =" 200"

OriginY =" 450"

xml:lang =" ru-RU”

UnicodeString =" & XU K BTyMaHe"”

FontUri =" file://C:/Windows/Fonts/Times. TTF"
Fill =" #O0OFF00"”

FontRenderingEmSize =" 20"

/>

<V —' & XU KBTyMaHe’ usingcompositionof’ e’ anddiaeresis—>
<{Glyphs

OriginX =" 200"

OriginY =" 500"

xml:lang =" ru-RU”
UnicodeString =" & XU K BTyMaHe”
Indices =" (1:2)72;142,0,-45"

FontUri =" C:\/Windows\/Fonts\/Times. TTF”

Fill =" #00FF00"”

FontRenderingEmSize =" 207

/>

<! —' & XU KBTyMaHe’ Forcedrenderingright-to-leftshowing
combiningmarkinlogicalorder——>

<{Glyphs

OriginX =" 200"

OriginY =" 550"

BidiLevel =" 1"

xml:lang =" ru-RU”
UnicodeString =" & XU K BTyMaHe”
Indices =" (1:2)72;142,0,-45"

FontUri =" file://C:/Windows/Fonts/Times. TTF"”
Fill =" #00FF00”

FontRenderingEmSize =" 20"

/>

{/Canvas>

[1565] AL F-IEARILII K/

(15661 415 H AR~ HLAE AT St T80T A8 ebsic 4017, a0 & 5 | ETE 58 A2, I mT AR
AT, LU IRV E A AR A i G Ak .

[1567] LA I FET

[1568]  *47E Unicode A3 HY B4 0 BRI B i B T TR A B 2 T — X — B, 3F B
TER G AR OMAP (AT ) R B94E, FF H. Unicode 4FH BTG LI, FIE RS
Al LMARIC B I .

[1569] 445 R F I I, N M 7EAR il PR LTI R 5] -

[1570] @A E—Xf—, A E M SR BT (T ) , BiE

[1571] @ — B E AN FIE, B3

[1572] @ KkAETAL—H AN F B, i@t OpenType FRAE N o

[1573] Y2 PG| n] fe AR T FARH) CMAP ( RIS ) & F IR T IR, B4 7E
FRid PRI R T AT PR R TR R OMAP K ()P TE I, YR TR R
5l

[1574] A B AR

(15751 4 BT 7 22 (A T 308 00 B8 (O 2 AR ) EMTX (/KSR ) R VMTX (SR B EE &) # P )
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TR ATRE B8 BE I, ST ARk 58 B2 n] LUARd Fh A8 I

[1576] TN, FIEHE B W ] LLAFRIC A B o 306 T 2500 247 L o2 52, HF A
X TR B R A TR R A B i T, T A o RIS X T 1 G Bl A v R R T S B AR
[FIRIA HR I 2 A 10 I A2

(15771 AR R T

[1578] X T BHA EHE WL R IEM T, TR &R DL A B .

[1579] 45

[1580]  LiRMidil py B HEQLRI SO T AR R4t T — AR hHe, T 418 e
G RN 2T AR R D N 2. X e SCT T ORI URE 6 R HESE, AT 3K
PR AE R G REAE T SRR — B AR Bl AT R SO . PR FEREIA I BA g R T
— P T LART A e S R BRI o ) U A N R e 2 T ) 56 4 DR LT O FLIES &% A 5 A i
TER B BT BN IR 1 P 25 1 77 2 A7 O 40 DR B4 DA IR SR ke 2o B DAXT &5
FFRFAEAT / 8070 3R & F IR & Rl 7 A U], SR a] ABRAR, BT BEEASOR) 22 5k 45 7 e X
(KA B AN B PR T I il R BOP 3R AH G #8717 LR AT 2 3R AR g S sk R
PHIA KR I AETE .
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